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3pi Robot from the Arduino
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1. Intr oduction

The Orangutan LV-168 attached to a 3-AA battery
holder.

Baby Orangutan B with included
header pins soldered in for

breadboard installation.

Arduino [http://www .arduino.cc/] �8�B�0�?�>�?�D�;�0�A�� �>�?�4�=���B�>�D�A�2�4�?�A�>�C�>�C�H�?�8�=�6�?�;�0�C�5�>�A�<�C�7�0�C�<�0�:�4�B�8�C�4�0�B�H�5�>�A�?�4�>�?�;�4�F�8�C�7
�;�8�C�C�;�4�4�;�4�2�C�A�>�=�8�2�B�4�G�?�4�A�8�4�=�2�4�C�>�6�4�C�8�=�C�>�C�7�4�F�>�A�;�3�>�5�<�8�2�A�>�2�>�=�C�A�>�;�;�4�A�B�0�=�3�4�<�1�4�3�3�4�3�?�A�>�6�A�0�<�<�8�=�6�	�)�7�4���A�3�D�8�=�>
�4�=�E�8�A�>�=�<�4�=�C�2�>�=�B�8�B�C�B�>�5�0�=�>�?�4�=���B�>�D�A�2�4�8�=�C�4�6�A�0�C�4�3�3�4�E�4�;�>�?�<�4�=�C�4�=�E�8�A�>�=�<�4�=�C�����������0�=�3�2�>�<�?�8�;�4�A���B�>�5�C�F�0�A�4�;�8�1�A�0�A�8�4�B��
�0�=�3�?�A�>�6�A�0�<�<�0�1�;�4�7�0�A�3�F�0�A�4�1�>�0�A�3�B�1�0�B�4�3�>�=�C�7�4�?�>�F�4�A�5�D�;�� �)�<�4�6�0�������0�=�3�� �)�<�4�6�0���
���<�8�2�A�>�2�>�=�C�A�>�;�;�4�A�B�	���4�2�0�D�B�4
�>�D�AOrangutan SV-xx8 [http://www .pololu.com/catalog/product/1227]�� Orangutan LV-168 [http://www .pololu.com/catalog/

product/775]�� �0�=�3Baby Orangutan B [http://www .pololu.com/catalog/product/1220] �A�>�1�>�C�2�>�=�C�A�>�;�;�4�A�B�D�B�4�C�7�4�B�4�B�0�<�4
�<�8�2�A�>�2�>�=�C�A�>�;�;�4�A�B���C�7�4�H�7�0�E�4�0�B�D�1�B�C�0�=�C�8�0�;�3�4�6�A�4�4�>�5�>�E�4�A�;�0�?�F�8�C�7���A�3�D�8�=�>�B�	�$�D�A�$�A�0�=�6�D�C�0�=�A�>�1�>�C�2�>�=�C�A�>�;�;�4�A�B�2�0�=
�C�7�4�A�4�5�>�A�4�1�4�0�=�0�C�C�A�0�2�C�8�E�4�0�;�C�4�A�=�0�C�8�E�4�C�>�>�5�5�8�2�8�0�;���A�3�D�8�=�>�7�0�A�3�F�0�A�4�5�>�A�C�7�>�B�4�0�;�A�4�0�3�H�5�0�<�8�;�8�0�A�F�8�C�7�C�7�4���A�3�D�8�=�>
�4�=�E�8�A�>�=�<�4�=�C���0�=�3�C�7�4�4�=�E�8�A�>�=�<�4�=�C�2�0�=�1�4�0�1�4�6�8�=�=�4�A���5�A�8�4�=�3�;�H�0�;�C�4�A�=�0�C�8�E�4�C�>�� �+�' �(�C�D�3�8�>�5�>�A�C�7�>�B�4�;�>�>�:�8�=�6�C�>�6�4�C
�B�C�0�A�C�4�3���F�8�C�7���$�A�0�=�6�D�C�0�=�B�	

Note: �)�7�4Pololu 3pi robot [http://www .pololu.com/catalog/product/975] �4�5�5�4�2�C�8�E�4�;�H�7�0�B�0�=�$�A�0�=�6�D�C�0�=�(�+��
�G�G���0�B�8�C�B�2�>�A�4���B�>�C�7�8�B�6�D�8�3�4�0�=�3�C�7�4�$�A�0�=�6�D�C�0�=���A�3�D�8�=�>�;�8�1�A�0�A�8�4�B�0�?�?�;�H�C�>�C�7�4���?�8�0�B�F�4�;�;�	���>�A�<�>�A�4
�8�=�5�>�A�<�0�C�8�>�=���>�=���C�7�4�����?�8�����?�;�4�0�B�4���B�4�4���C�7�43pi userÕs guide[http://www .pololu.com/docs/0J21]�	
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�, �8�C�7�B�>�<�4�<�8�=�>�A�2�7�0�=�6�4�B�C�>�C�7�4���A�3�D�8�=�>�B�>�5�C�F�0�A�4�2�>�=�5�8�6�D�A�0�C�8�>�=�5�8�;�4�B���8�C�1�4�2�>�<�4�B�?�>�B�B�8�1�;�4�C�>�?�A�>�6�A�0�<�>�D�A
�$�A�0�=�6�D�C�0�=�B�0�=�3���?�8�A�>�1�>�C�D�B�8�=�6�C�7�4���A�3�D�8�=�>������ �0�=�3�;�8�1�A�0�A�8�4�B�	�)�7�8�B�6�D�8�3�4�F�8�;�;�B�C�4�?�H�>�D�C�7�A�>�D�6�7�C�7�4�?�A�>�2�4�B�B�>�5
�A�4�2�>�=�5�8�6�D�A�8�=�6�C�7�4���A�3�D�8�=�>�������� �0�=�3�8�C�F�8�;�;�?�A�>�E�8�3�4�0�B�4�A�8�4�B�>�5�2�D�B�C�>�<�;�8�1�A�0�A�8�4�B�C�7�0�C�F�8�;�;�<�0�:�4�8�C�4�0�B�H�5�>�A�H�>�D�C�>
�8�=�C�4�A�5�0�2�4���F�8�C�7���0�;�;���>�5���C�7�4���$�A�0�=�6�D�C�0�=�O�B�
���?�8�O�B���>�=�1�>�0�A�3���7�0�A�3�F�0�A�4�	

�$�=�4�:�4�H�3�8�5�5�4�A�4�=�2�4�1�4�C�F�4�4�=�B�C�0�=�3�0�A�3���A�3�D�8�=�>�1�>�0�A�3�B�0�=�3�C�7�4�$�A�0�=�6�D�C�0�=�A�>�1�>�C�2�>�=�C�A�>�;�;�4�A�B�8�B�C�7�0�C�<�>�B�C���A�3�D�8�=�>�B
�2�>�<�4�F�8�C�7�8�=�C�4�6�A�0�C�4�3�*�(�����C�>���B�4�A�8�0�;�0�3�0�?�C�4�A�B���F�7�8�2�7�0�;�;�>�F�H�>�D�C�>�2�>�=�=�4�2�C�C�7�4�<�C�>�H�>�D�A�2�>�<�?�D�C�4�A�0�=�3�?�A�>�6�A�0�<
�C�7�4�<�C�7�A�>�D�6�7�?�A�4���;�>�0�3�4�3�1�>�>�C�;�>�0�3�4�A�B���F�7�8�;�4�$�A�0�=�6�D�C�0�=�B�;�0�2�:�8�=�C�4�6�A�0�C�4�3�*�(�����C�>���B�4�A�8�0�;�0�3�0�?�C�4�A�B�	���B�B�D�2�7���5�>�A�C�7�4
�$�A�0�=�6�D�C�0�=�(�+���G�G�����!�+�������� �0�=�3���?�8�A�>�1�>�C���F�4�A�4�2�>�<�<�4�=�3�H�>�D�?�A�>�6�A�0�<�C�7�4�$�A�0�=�6�D�C�0�=�B�>�A���?�8�A�>�1�>�C�D�B�8�=�6�0�=
�� �+�' ���(�%���A�4�5�4�A�A�4�3�C�>�0�B�����(�%�8�=�C�7�4���A�3�D�8�=�>�F�>�A�;�3���?�A�>�6�A�0�<�<�4�A�B�D�2�7�0�B�>�D�AUSB AVR Programmer
[http://www .pololu.com/catalog/product/1300]�	 ���H�C�0�:�8�=�6�C�7�8�B�0�?�?�A�>�0�2�7�0�=�3�;�4�0�E�8�=�6�>�5�5�C�7�4�1�>�>�C�;�>�0�3�4�A���H�>�D�6�0�8�=�0�=�4�G�C�A�0
�
 � �����>�5���?�A�>�6�A�0�<���B�?�0�2�4�	���.�>�D���0�;�B�>���0�E�>�8�3���C�7�4���1�>�>�C�;�>�0�3�4�A���3�4�;�0�H���F�7�4�=���H�>�D���?�>�F�4�A���D�?���>�A���A�4�B�4�C���C�7�4���1�>�0�A�3�	
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Pololu USB AVR programmer with included six-
pin ISP cable.

Note: �)�7�8�B�3�>�2�D�<�4�=�C�0�?�?�;�8�4�B�>�=�;�H�C�>�C�7�43pi robot [http://www .pololu.com/catalog/product/975] �0�=�3
Orangutan SV-xx8 [http://www .pololu.com/catalog/product/1227]�� Orangutan LV-168
[http://www .pololu.com/catalog/product/775]�� �0�=�3Baby Orangutan B [http://www .pololu.com/catalog/product/

1220] �A�>�1�>�C�2�>�=�C�A�>�;�;�4�A�B�	���>�A�B�8�<�?�;�8�2�8�C�H�� �C�7�4�;�0�C�C�4�A�C�7�A�4�4�3�4�E�8�2�4�B�F�8�;�;�1�4�A�4�5�4�A�A�4�3�C�>�5�A�>�<�C�7�8�B�?�>�8�=�C
�>�=�0�BÒOrangutansÓ�� �D�=�;�4�B�B�0�3�8�B�C�8�=�2�C�8�>�=�=�4�4�3�B�C�>�1�4�<�0�3�4�1�4�C�F�4�4�=�B�?�4�2�8�5�8�2�$�A�0�=�6�D�C�0�=�<�>�3�4�;�B�	
�)�7�8�B�3�>�2�D�<�4�=�C�3�>�4�Bnot �0�?�?�;�H�C�>�C�7�4�>�A�8�6�8�=�0�;Orangutan [http://www .pololu.com/catalog/product/225]��
Baby Orangutan [http://www .pololu.com/catalog/product/215]��Orangutan X2 [http://www .pololu.com/catalog/

product/738]�����>�AOrangutan SVP[http://www .pololu.com/catalog/product/1325]�A�>�1�>�C���2�>�=�C�A�>�;�;�4�A�B�	
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2. ATmega168/328-Arduino Pin Mapping
���=�>�D�A�B�C�0�=�3�0�A�3�$�A�0�=�6�D�C�0�=�0�=�3���?�8�3�>�2�D�<�4�=�C�0�C�8�>�=���F�4�D�B�4�C�7�4�B�0�<�4�2�>�=�E�4�=�C�8�>�=�C�7�0�C���C�<�4�;�D�B�4�B�8�=�8�C�B�� �)�<�4�6�0�������

���
�� �3�0�C�0�B�7�4�4�C���A�4�5�4�A�A�8�=�6�C�>�?�8�=�B�1�H�C�7�4�8�A�0�B�B�>�2�8�0�C�4�3�?�>�A�C�B�	���>�A�4�G�0�<�?�;�4���?�8�=�%�����8�B�?�8�=�� �>�5�?�>�A�C���	 �)�7�8�B�2�>�=�E�4�=�C�8�>�=�8�B
�D�B�4�3�1�4�2�0�D�B�4�4�0�2�7�?�>�A�C�8�B�2�>�=�C�A�>�;�;�4�3�1�H�8�C�B�>�F�=�� �+�' �A�4�6�8�B�C�4�A�B���0�=�3�C�7�4�1�8�C�B�>�5�C�7�4�B�4�A�4�6�8�B�C�4�A�B�2�>�A�A�4�B�?�>�=�3�C�>�8�=�3�8�E�8�3�D�0�;
�?�8�=�B�	

�)�7�4���A�3�D�8�=�>�8�=�B�D�;�0�C�4�B�C�7�4�D�B�4�A�5�A�>�<�C�7�8�B�;�4�E�4�;�>�5�3�4�C�0�8�;���A�4�5�4�A�A�8�=�6�C�>�C�7�4���
�$�?�8�=�B�0�B�3�8�6�8�C�0�;�?�8�=�B�� �L���� �0�=�3�0�=�0�;�>�6
�8�=�?�D�C�B�� �L���	�#�>�C�4�C�7�0�C�C�7�8�B�C�4�A�<�8�=�>�;�>�6�H�2�0�=�1�4�0�1�8�C�<�8�B�;�4�0�3�8�=�6�B�8�=�2�4�0�=�0�;�>�6�8�=�?�D�C�B�� �L�� �2�0�=�0�;�B�>�1�4�D�B�4�3�0�B�6�4�=�4�A�0�;
�?�D�A�?�>�B�4���3�8�6�8�C�0�;�����
�$���?�8�=�B�����A�4�5�4�A�A�4�3���C�>���0�B���3�8�6�8�C�0�;���?�8�=�B���������L���������	

�. �>�D�2�0�=�E�8�B�8�Chttp://www.arduino.cc/en/Hacking/PinMapping168[http://www .arduino.cc/en/Hacking/PinMapping168] �C�>
�B�4�4�4�G�0�2�C�;�H�7�>�F�C�7�4�<�4�6�0�������
���
�� �?�8�=�B�0�A�4�<�0�?�?�4�3�C�>���A�3�D�8�=�>�?�8�=�B�	�#�>�C�4�C�7�0�C�C�7�8�B�?�0�6�4�B�7�>�F�B�0�
�����?�8�=�����%�?�0�2�:�0�6�4
�2�7�8�?�F�7�8�;�4�C�7�4�$�A�0�=�6�D�C�0�=�B�2�0�A�A�H�B�<�0�;�;�4�A���
���?�8�=�"�!�� �?�0�2�:�0�6�4�B�C�7�0�C�2�>�=�C�0�8�=�C�F�>�0�3�3�8�C�8�>�=�0�;�3�4�3�8�2�0�C�4�3�0�=�0�;�>�6�8�=�?�D�C�B��
�������� �0�=�3���������	 ���=�C�7�4���A�3�D�8�=�>�4�=�E�8�A�>�=�<�4�=�C���C�7�4�B�4�?�8�=�B�1�4�2�>�<�4�0�A�3�D�8�=�>�0�=�0�;�>�6�8�=�?�D�C�B�� �0�=�3�����A�4�B�?�4�2�C�8�E�4�;�H�	�)�7�4
�5�>�;�;�>�F�8�=�6���3�8�0�6�A�0�<���2�>�<�4�B���5�A�>�<���C�7�4���?�0�6�4���;�8�=�:�4�3���0�1�>�E�4��
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2.a.Orangutan SV-xx8 and LV-168 Pin Mappings
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Orangutan SV-168 bottom view with dimensions
(Arduino pin mapping).

Orangutan LV-168 bottom view with dimensions
(Arduino pin mapping).
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Pin Assignment Table Sorted by Function
Function Arduino Pin mega168 Pin

�3�8�6�8�C�0�;�����
�$�B�����G����
�3�8�6�8�C�0�;���?�8�=�B�������0�=�3����
�0�=�0�;�>�6���8�=�?�D�C�B�������L����

�%���������%������
�%�������L���%����

�0�=�0�;�>�6���8�=�?�D�C�B�����G���� �0�=�0�;�>�6���8�=�?�D�C�B�������L�����%�������L���%����������������������������

�<�>�C�>�A�������2�>�=�C�A�>�;���������0�=�3�������3�8�6�8�C�0�;���?�8�=�B�������0�=�3�����%�������0�=�3���%����

�<�>�C�>�A���
���2�>�=�C�A�>�;���������0�=�3�������3�8�6�8�C�0�;���?�8�=�B�������0�=�3������ �%�������0�=�3���%����

�A�4�3���D�B�4�A���!���� �3�8�6�8�C�0�;���?�8�=���� �%����

�6�A�4�4�=���D�B�4�A���!���� �3�8�6�8�C�0�;���?�8�=���� �%����

�D�B�4�A���?�D�B�7�1�D�C�C�>�=�B�����G�����3�8�6�8�C�0�;���8�=�?�D�C�B�����������
�����0�=�3�������%���������%���������0�=�3���%����

�1�D�I�I�4�A �3�8�6�8�C�0�;���?�8�=������ �%���


�!�������2�>�=�C�A�>�;�����'�(�����'�
�,�������� �3�8�6�8�C�0�;���?�8�=�B���
�����������0�=�3�����%���
�����%���������0�=�3���%����

�!�������3�0�C�0���������1�8�C�������������L�����������3�8�6�8�C�0�;���?�8�=�B�����������
�������������0�=�3�����%���������%���������%���������0�=�3���%����

�D�B�4�A���C�A�8�<�<�4�A���?�>�C�4�=�C�8�>�<�4�C�4�A
�0�=�0�;�>�6���8�=�?�D�C����
���C�7�A�>�D�6�7���9�D�<�?�4�A��

��������

�C�4�<�?�4�A�0�C�D�A�4���B�4�=�B�>�A�����!�+�����������>�=�;�H��
�1�0�C�C�4�A�H���E�>�;�C�0�6�4���<�>�=�8�C�>�A�����(�+�����������>�=�;�H��

�0�=�0�;�>�6���8�=�?�D�C����
���C�7�A�>�D�6�7���(�"�)���9�D�<�?�4�A��

��������

�����(�%���?�A�>�6�A�0�<�<�8�=�6���;�8�=�4�B�����G�����3�8�6�8�C�0�;���?�8�=�B�������������
�����0�=�3�������%���������%���������%����

�A�4�B�4�C���?�D�B�7�1�D�C�C�>�= �A�4�B�4�C �%����

�*���' �)�����'�-���0�=�3���)�-�� �3�8�6�8�C�0�;���?�8�=�B�������0�=�3�����%�������0�=�3���%����

���
���
�)�,�������(�������0�=�3���(���!�� �0�=�0�;�>�6���8�=�?�D�C�B�������0�=�3�����%�������0�=�3���%����

�(�%�� �8�=�0�2�2�4�B�B�0�1�;�4���C�>���D�B�4�A
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Pin Assignment Table Sorted by Pin
Arduino Pin Orangutan Function Notes/Alternate Functions

�3�8�6�8�C�0�;���?�8�=�����3�8�6�8�C�0�;�����
�$ �*�(���' �)���8�=�?�D�C���?�8�=�����'�-����

�3�8�6�8�C�0�;���?�8�=�����3�8�6�8�C�0�;�����
�$
connected to red user LED���7�8�6�7���C�D�A�=�B���!�������>�=��
�*�(���' �)���>�D�C�?�D�C���?�8�=�����)�-����

�3�8�6�8�C�0�;���?�8�=���
LCD control line RS �4�G�C�4�A�=�0�;���8�=�C�4�A�A�D�?�C�����������#�)����

�3�8�6�8�C�0�;���?�8�=����M2 control line �)�8�<�4�A�
���%�,�"���>�D�C�?�D�C���������$���
����

�3�8�6�8�C�0�;���?�8�=����LCD control line E
�*�(���' �)���4�G�C�4�A�=�0�;���2�;�>�2�:���8�=�?�D�C�
�>�D�C�?�D�C�����-��� ��
�)�8�<�4�A�����4�G�C�4�A�=�0�;���2�>�D�=�C�4�A�����)����

�3�8�6�8�C�0�;���?�8�=����M1 control line �)�8�<�4�A�����%�,�"���>�D�C�?�D�C���������$��������

�3�8�6�8�C�0�;���?�8�=����M1 control line �)�8�<�4�A�����%�,�"���>�D�C�?�D�C���������$��������

�3�8�6�8�C�0�;���?�8�=����LCD data line DB7 connected to green user LED���7�8�6�7���C�D�A�=�B���!�������>�=��

�3�8�6�8�C�0�;���?�8�=����LCD control line R/W
�)�8�<�4�A�����8�=�?�D�C���2�0�?�C�D�A�4���������%����
�3�8�E�8�3�4�3���B�H�B�C�4�<���2�;�>�2�:���>�D�C�?�D�C�������!� ����

�3�8�6�8�C�0�;���?�8�=����LCD data line DB4
user pushbutton���?�A�4�B�B�8�=�6���?�D�;�;�B���?�8�=���;�>�F��
�)�8�<�4�A�����%�,�"���>�D�C�?�D�C���������$��������

�3�8�6�8�C�0�;���?�8�=������buzzer �)�8�<�4�A�����%�,�"���>�D�C�?�D�C���������$��������

�3�8�6�8�C�0�;���?�8�=������ M2 control line
�)�8�<�4�A�
���%�,�"���>�D�C�?�D�C���������$���
����
���(�%���?�A�>�6�A�0�<�<�8�=�6���;�8�=�4

�3�8�6�8�C�0�;���?�8�=�����
LCD data line DB5
user pushbutton���?�A�4�B�B�8�=�6���?�D�;�;�B���?�8�=���;�>�F��
Caution: also an ISP programming line

�3�8�6�8�C�0�;���?�8�=������LCD data line DB6
user pushbutton���?�A�4�B�B�8�=�6���?�D�;�;�B���?�8�=���;�>�F��
Caution: also an ISP programming line

�0�=�0�;�>�6���8�=�?�D�C�����0�=�0�;�>�6���8�=�?�D�C���0�=�3���3�8�6�8�C�0�;�����
�$���������8�=�?�D�C���2�7�0�=�=�4�;������������������

�0�=�0�;�>�6���8�=�?�D�C�����0�=�0�;�>�6���8�=�?�D�C���0�=�3���3�8�6�8�C�0�;�����
�$���������8�=�?�D�C���2�7�0�=�=�4�;������������������

�0�=�0�;�>�6���8�=�?�D�C���
�0�=�0�;�>�6���8�=�?�D�C���0�=�3���3�8�6�8�C�0�;�����
�$���������8�=�?�D�C���2�7�0�=�=�4�;���
�����������
��

�0�=�0�;�>�6���8�=�?�D�C�����0�=�0�;�>�6���8�=�?�D�C���0�=�3���3�8�6�8�C�0�;�����
�$���������8�=�?�D�C���2�7�0�=�=�4�;������������������

�0�=�0�;�>�6���8�=�?�D�C�����0�=�0�;�>�6���8�=�?�D�C���0�=�3���3�8�6�8�C�0�;�����
�$
���������8�=�?�D�C���2�7�0�=�=�4�;������������������
���
���
�)�,�����8�=�?�D�C�
�>�D�C�?�D�C���3�0�C�0���;�8�=�4�����(������

�0�=�0�;�>�6���8�=�?�D�C�����0�=�0�;�>�6���8�=�?�D�C���0�=�3���3�8�6�8�C�0�;�����
�$
���������8�=�?�D�C���2�7�0�=�=�4�;������������������
���
���
�)�,�����2�;�>�2�:���;�8�=�4�����(���!��

�0�=�0�;�>�6���8�=�?�D�C�����3�4�3�8�2�0�C�4�3���0�=�0�;�>�6���8�=�?�D�C
SMT-jumpered to temperature sensor���!�+�����������>�=�;�H��
SMT-jumpered to battery voltage monitor���(�+�����������>�=�;�H��
���������8�=�?�D�C���2�7�0�=�=�4�;������������������

�0�=�0�;�>�6���8�=�?�D�C�����3�4�3�8�2�0�C�4�3���0�=�0�;�>�6���8�=�?�D�C
jumpered to user trimmer potentiometer
���������8�=�?�D�C���2�7�0�=�=�4�;������������������

�A�4�B�4�C �A�4�B�4�C���?�D�B�7�1�D�C�C�>�=
�8�=�C�4�A�=�0�;�;�H���?�D�;�;�4�3���7�8�6�7�����0�2�C�8�E�4���;�>�F
�3�8�6�8�C�0�;�����
�$���3�8�B�0�1�;�4�3���1�H���3�4�5�0�D�;�C
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2.b.Baby Orangutan B Pin Mappings
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Pin Assignment Table Sorted by Function
Function Arduino Pin mega168 Pin

�3�8�6�8�C�0�;�����
�$�B�����G������
�3�8�6�8�C�0�;���?�8�=�B�������L���
���������������L�������������
��������
�0�=�0�;�>�6���8�=�?�D�C�B�������L����

�%�������L���%���
�����%���������%������
�%�������L���%���
�����%���������%������
�%�������L���%����

�0�=�0�;�>�6���8�=�?�D�C�B�����G���� �0�=�0�;�>�6���8�=�?�D�C�B�������L���� �%�������L���%����������������������������

�<�>�C�>�A�������2�>�=�C�A�>�;���������0�=�3�������3�8�6�8�C�0�;���?�8�=�B�������0�=�3�����%�������0�=�3���%����

�<�>�C�>�A���
���2�>�=�C�A�>�;���������0�=�3�������3�8�6�8�C�0�;���?�8�=�B�������0�=�3������ �%�������0�=�3���%����

�A�4�3���D�B�4�A���!���� �3�8�6�8�C�0�;���?�8�=���� �%����

�D�B�4�A���C�A�8�<�<�4�A���?�>�C�4�=�C�8�>�<�4�C�4�A�0�=�0�;�>�6���8�=�?�D�C���� ��������

�����(�%���?�A�>�6�A�0�<�<�8�=�6���;�8�=�4�B�����G�����3�8�6�8�C�0�;���?�8�=�B�������������
�����0�=�3������ �%���������%���������%����

�'���(���) �A�4�B�4�C �%����

�*���' �)�����'�-���0�=�3���)�-�� �3�8�6�8�C�0�;���?�8�=�B�������0�=�3�����%�������0�=�3���%����

���
���
�)�,�������(�������0�=�3���(���!�� �0�=�0�;�>�6���8�=�?�D�C�B�������0�=�3�����%�������0�=�3���%����

�(�%�� �8�=�0�2�2�4�B�B�0�1�;�4���C�>���D�B�4�A

�)�8�<�4�A�����%�,�"���>�D�C�?�D�C�B���������0�=�3�������3�8�6�8�C�0�;���?�8�=�B�������0�=�3�������%�������0�=�3���%���
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Pin Assignment Table Sorted by Pin
Arduino Pin Orangutan Function Notes/Alternate Functions

�3�8�6�8�C�0�;���?�8�=�����3�8�6�8�C�0�;�����
�$ �*�(���' �)���8�=�?�D�C���?�8�=�����'�-����

�3�8�6�8�C�0�;���?�8�=�����3�8�6�8�C�0�;�����
�$
connected to red user LED���7�8�6�7���C�D�A�=�B���!�������>�=��
�*�(���' �)���>�D�C�?�D�C���?�8�=�����)�-����

�3�8�6�8�C�0�;���?�8�=���
�3�8�6�8�C�0�;�����
�$ �4�G�C�4�A�=�0�;���8�=�C�4�A�A�D�?�C�����������#�)����

�3�8�6�8�C�0�;���?�8�=����M2 control line �)�8�<�4�A�
���%�,�"���>�D�C�?�D�C���������$���
����

�3�8�6�8�C�0�;���?�8�=�����3�8�6�8�C�0�;�����
�$
�*�(���' �)���4�G�C�4�A�=�0�;���2�;�>�2�:���8�=�?�D�C�
�>�D�C�?�D�C�����-��� ��
�)�8�<�4�A�����4�G�C�4�A�=�0�;���2�>�D�=�C�4�A�����)����

�3�8�6�8�C�0�;���?�8�=����M1 control line �)�8�<�4�A�����%�,�"���>�D�C�?�D�C���������$��������

�3�8�6�8�C�0�;���?�8�=����M1 control line �)�8�<�4�A�����%�,�"���>�D�C�?�D�C���������$��������

�3�8�6�8�C�0�;���?�8�=�����3�8�6�8�C�0�;�����
�$

�3�8�6�8�C�0�;���?�8�=�����3�8�6�8�C�0�;�����
�$
�)�8�<�4�A�����8�=�?�D�C���2�0�?�C�D�A�4���������%����
�3�8�E�8�3�4�3���B�H�B�C�4�<���2�;�>�2�:���>�D�C�?�D�C�������!� ����

�3�8�6�8�C�0�;���?�8�=�����3�8�6�8�C�0�;�����
�$ �)�8�<�4�A�����%�,�"���>�D�C�?�D�C���������$��������

�3�8�6�8�C�0�;���?�8�=�������3�8�6�8�C�0�;�����
�$ �)�8�<�4�A�����%�,�"���>�D�C�?�D�C���������$��������

�3�8�6�8�C�0�;���?�8�=������ M2 control line
�)�8�<�4�A�
���%�,�"���>�D�C�?�D�C���������$���
����
���(�%���?�A�>�6�A�0�<�<�8�=�6���;�8�=�4

�3�8�6�8�C�0�;���?�8�=�����
�3�8�6�8�C�0�;�����
�$ Caution: also an ISP programming line

�3�8�6�8�C�0�;���?�8�=�������3�8�6�8�C�0�;�����
�$ Caution: also an ISP programming line

�0�=�0�;�>�6���8�=�?�D�C�����0�=�0�;�>�6���8�=�?�D�C���0�=�3���3�8�6�8�C�0�;�����
�$���������8�=�?�D�C���2�7�0�=�=�4�;������������������

�0�=�0�;�>�6���8�=�?�D�C�����0�=�0�;�>�6���8�=�?�D�C���0�=�3���3�8�6�8�C�0�;�����
�$���������8�=�?�D�C���2�7�0�=�=�4�;������������������

�0�=�0�;�>�6���8�=�?�D�C���
�0�=�0�;�>�6���8�=�?�D�C���0�=�3���3�8�6�8�C�0�;�����
�$���������8�=�?�D�C���2�7�0�=�=�4�;���
�����������
��

�0�=�0�;�>�6���8�=�?�D�C�����0�=�0�;�>�6���8�=�?�D�C���0�=�3���3�8�6�8�C�0�;�����
�$���������8�=�?�D�C���2�7�0�=�=�4�;������������������

�0�=�0�;�>�6���8�=�?�D�C�����0�=�0�;�>�6���8�=�?�D�C���0�=�3���3�8�6�8�C�0�;�����
�$
���������8�=�?�D�C���2�7�0�=�=�4�;������������������
���
���
�)�,�����8�=�?�D�C�
�>�D�C�?�D�C���3�0�C�0���;�8�=�4�����(������

�0�=�0�;�>�6���8�=�?�D�C�����0�=�0�;�>�6���8�=�?�D�C���0�=�3���3�8�6�8�C�0�;�����
�$
���������8�=�?�D�C���2�7�0�=�=�4�;������������������
���
���
�)�,�����2�;�>�2�:���;�8�=�4�����(���!��

�0�=�0�;�>�6���8�=�?�D�C�����3�4�3�8�2�0�C�4�3���0�=�0�;�>�6���8�=�?�D�C���������8�=�?�D�C���2�7�0�=�=�4�;������������������

�0�=�0�;�>�6���8�=�?�D�C�����3�4�3�8�2�0�C�4�3���0�=�0�;�>�6���8�=�?�D�C
connected to user trimmer potentiometer
���������8�=�?�D�C���2�7�0�=�=�4�;������������������

�A�4�B�4�C �'���(���) �?�8�=
�8�=�C�4�A�=�0�;�;�H���?�D�;�;�4�3���7�8�6�7�����0�2�C�8�E�4���;�>�F
�3�8�6�8�C�0�;�����
�$���3�8�B�0�1�;�4�3���1�H���3�4�5�0�D�;�C
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2.c.3pi Robot Pin Mappings

General features of the Pololu 3pi robot, top view.
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Labeled bottom view of the Pololu 3pi robot.
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Specific features of the Pololu 3pi robot, top view.
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Pin Assignment Table Sorted by Function
Function Arduino Pin mega168 Pin

�5�A�4�4���3�8�6�8�C�0�;�����
�$�B�����G����
���A�4�<�>�E�4���%�������9�D�<�?�4�A���C�>���5�A�4�4���3�8�6�8�C�0�;���?�8�=��������

�3�8�6�8�C�0�;���?�8�=�B�������������������%���������%���������%����

�5�A�4�4���0�=�0�;�>�6���8�=�?�D�C�B�����8�5���H�>�D���A�4�<�>�E�4���9�D�<�?�4�A�B�����G�����0�=�0�;�>�6���8�=�?�D�C�B�������L�����%����������������������������

�<�>�C�>�A���������;�4�5�C���<�>�C�>�A�����2�>�=�C�A�>�;���������0�=�3�������3�8�6�8�C�0�;���?�8�=�B�������0�=�3�����%�������0�=�3���%����

�<�>�C�>�A���
�����A�8�6�7�C���<�>�C�>�A�����2�>�=�C�A�>�;���������0�=�3�������3�8�6�8�C�0�;���?�8�=�B�������0�=�3������ �%�������0�=�3���%����

�&�)�'���'�����A�4�5�;�4�2�C�0�=�2�4���B�4�=�B�>�A�B�����;�4�5�C���C�>���A�8�6�7�C�����G�����3�8�6�8�C�0�;���?�8�=�B���������L�������%�������L���%����

�A�4�3�����;�4�5�C�����D�B�4�A���!���� �3�8�6�8�C�0�;���?�8�=���� �%����

�6�A�4�4�=�����A�8�6�7�C�����D�B�4�A���!���� �3�8�6�8�C�0�;���?�8�=���� �%����

�D�B�4�A���?�D�B�7�1�D�C�C�>�=�B�����;�4�5�C���C�>���A�8�6�7�C�����G�����3�8�6�8�C�0�;���8�=�?�D�C�B�����������
�����0�=�3�������%���������%���������0�=�3���%����

�1�D�I�I�4�A �3�8�6�8�C�0�;���?�8�=������ �%���


�!�������2�>�=�C�A�>�;�����'�(�����'�
�,�������� �3�8�6�8�C�0�;���?�8�=�B���
�����������0�=�3�����%���
�����%���������0�=�3���%����

�!�������3�0�C�0���������1�8�C�������������L���������� �3�8�6�8�C�0�;���?�8�=�B�����������
�������������0�=�3�����%���������%���������%���������0�=�3���%����

�A�4�5�;�4�2�C�0�=�2�4���B�4�=�B�>�A�����'���!�������2�>�=�C�A�>�;
���3�A�8�E�4���;�>�F���C�>���C�D�A�=�����'���!�����B���>�5�5��

�3�8�6�8�C�0�;���?�8�=������
���C�7�A�>�D�6�7���9�D�<�?�4�A��

�%����

�D�B�4�A���C�A�8�<�<�4�A���?�>�C�4�=�C�8�>�<�4�C�4�A
�0�=�0�;�>�6���8�=�?�D�C����
���C�7�A�>�D�6�7���9�D�<�?�4�A��

��������

�
�
���A�3�B���>�5���1�0�C�C�4�A�H���E�>�;�C�0�6�4
�0�=�0�;�>�6���8�=�?�D�C����
���C�7�A�>�D�6�7���9�D�<�?�4�A��

��������

�����(�%���?�A�>�6�A�0�<�<�8�=�6���;�8�=�4�B�����G�����3�8�6�8�C�0�;���?�8�=�B�������������
�����0�=�3�������%���������%���������%����

�A�4�B�4�C���?�D�B�7�1�D�C�C�>�= �A�4�B�4�C �%����

�*���' �)�����'�-���0�=�3���)�-�� �3�8�6�8�C�0�;���?�8�=�B�������0�=�3�����%�������0�=�3���%����

���
���
�)�,�� �8�=�0�2�2�4�B�B�0�1�;�4���C�>���D�B�4�A

�(�%�� �8�=�0�2�2�4�B�B�0�1�;�4���C�>���D�B�4�A
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Pin Assignment Table Sorted by Pin
Arduino Pin Orangutan Function Notes/Alternate Functions

�3�8�6�8�C�0�;���?�8�=�����5�A�4�4���3�8�6�8�C�0�;�����
�$ �*�(���' �)���8�=�?�D�C���?�8�=�����'�-����

�3�8�6�8�C�0�;���?�8�=�����5�A�4�4���3�8�6�8�C�0�;�����
�$
connected to red user LED���7�8�6�7���C�D�A�=�B���!�������>�=��
�*�(���' �)���>�D�C�?�D�C���?�8�=�����)�-����

�3�8�6�8�C�0�;���?�8�=���
LCD control line RS �4�G�C�4�A�=�0�;���8�=�C�4�A�A�D�?�C�����������#�)����

�3�8�6�8�C�0�;���?�8�=����M2 control line �)�8�<�4�A�
���%�,�"���>�D�C�?�D�C���������$���
����

�3�8�6�8�C�0�;���?�8�=����LCD control line E
�*�(���' �)���4�G�C�4�A�=�0�;���2�;�>�2�:���8�=�?�D�C�
�>�D�C�?�D�C�����-��� ��
�)�8�<�4�A�����4�G�C�4�A�=�0�;���2�>�D�=�C�4�A�����)����

�3�8�6�8�C�0�;���?�8�=����M1 control line �)�8�<�4�A�����%�,�"���>�D�C�?�D�C���������$��������

�3�8�6�8�C�0�;���?�8�=����M1 control line �)�8�<�4�A�����%�,�"���>�D�C�?�D�C���������$��������

�3�8�6�8�C�0�;���?�8�=����LCD data line DB7 connected to green user LED���7�8�6�7���C�D�A�=�B���!�������>�=��

�3�8�6�8�C�0�;���?�8�=����LCD control line R/W
�)�8�<�4�A�����8�=�?�D�C���2�0�?�C�D�A�4���������%����
�3�8�E�8�3�4�3���B�H�B�C�4�<���2�;�>�2�:���>�D�C�?�D�C�������!� ����

�3�8�6�8�C�0�;���?�8�=����LCD data line DB4
user pushbutton���?�A�4�B�B�8�=�6���?�D�;�;�B���?�8�=���;�>�F��
�)�8�<�4�A�����%�,�"���>�D�C�?�D�C���������$��������

�3�8�6�8�C�0�;���?�8�=������buzzer �)�8�<�4�A�����%�,�"���>�D�C�?�D�C���������$��������

�3�8�6�8�C�0�;���?�8�=������ M2 control line
�)�8�<�4�A�
���%�,�"���>�D�C�?�D�C���������$���
����
���(�%���?�A�>�6�A�0�<�<�8�=�6���;�8�=�4

�3�8�6�8�C�0�;���?�8�=�����
LCD data line DB5
user pushbutton���?�A�4�B�B�8�=�6���?�D�;�;�B���?�8�=���;�>�F��
Caution: also an ISP programming line

�3�8�6�8�C�0�;���?�8�=������LCD data line DB6
user pushbutton���?�A�4�B�B�8�=�6���?�D�;�;�B���?�8�=���;�>�F��
Caution: also an ISP programming line

�3�8�6�8�C�0�;���?�8�=������QTR-RC reflectance sensor
���3�A�8�E�4���7�8�6�7���5�>�A���������D�B�����C�7�4�=���F�0�8�C���5�>�A���;�8�=�4���8�=�?�D�C���C�>���6�>���;�>�F��
�B�4�=�B�>�A���;�0�1�4�;�4�3���%���������;�4�5�C�<�>�B�C���B�4�=�B�>�A��

�3�8�6�8�C�0�;���?�8�=������QTR-RC reflectance sensor
���3�A�8�E�4���7�8�6�7���5�>�A���������D�B�����C�7�4�=���F�0�8�C���5�>�A���;�8�=�4���8�=�?�D�C���C�>���6�>���;�>�F��
�B�4�=�B�>�A���;�0�1�4�;�4�3���%����

�3�8�6�8�C�0�;���?�8�=������QTR-RC reflectance sensor
���3�A�8�E�4���7�8�6�7���5�>�A���������D�B�����C�7�4�=���F�0�8�C���5�>�A���;�8�=�4���8�=�?�D�C���C�>���6�>���;�>�F��
�B�4�=�B�>�A���;�0�1�4�;�4�3���%���
�����2�4�=�C�4�A���B�4�=�B�>�A��

�3�8�6�8�C�0�;���?�8�=������QTR-RC reflectance sensor
���3�A�8�E�4���7�8�6�7���5�>�A���������D�B�����C�7�4�=���F�0�8�C���5�>�A���;�8�=�4���8�=�?�D�C���C�>���6�>���;�>�F��
�B�4�=�B�>�A���;�0�1�4�;�4�3���%����

�3�8�6�8�C�0�;���?�8�=������QTR-RC reflectance sensor
���3�A�8�E�4���7�8�6�7���5�>�A���������D�B�����C�7�4�=���F�0�8�C���5�>�A���;�8�=�4���8�=�?�D�C���C�>���6�>���;�>�F��
�B�4�=�B�>�A���;�0�1�4�;�4�3���%���������A�8�6�7�C�<�>�B�C���B�4�=�B�>�A��

�3�8�6�8�C�0�;���?�8�=�������0�=�0�;�>�6���8�=�?�D�C���0�=�3���3�8�6�8�C�0�;�����
�$
jumpered to sensorsÕ IR LEDs���3�A�8�E�8�=�6���;�>�F���C�D�A�=�B���>�5�5���4�<�8�C�C�4�A�B��
���������8�=�?�D�C���2�7�0�=�=�4�;������������������

�0�=�0�;�>�6���8�=�?�D�C�����3�4�3�8�2�0�C�4�3���0�=�0�;�>�6���8�=�?�D�C
jumpered to 2/3rds of battery voltage
���������8�=�?�D�C���2�7�0�=�=�4�;������������������

�0�=�0�;�>�6���8�=�?�D�C�����3�4�3�8�2�0�C�4�3���0�=�0�;�>�6���8�=�?�D�C
jumpered to user trimmer potentiometer
���������8�=�?�D�C���2�7�0�=�=�4�;������������������

�A�4�B�4�C �A�4�B�4�C���?�D�B�7�1�D�C�C�>�=�8�=�C�4�A�=�0�;�;�H���?�D�;�;�4�3���7�8�6�7�����0�2�C�8�E�4���;�>�F�3�8�6�8�C�0�;�����
�$���3�8�B�0�1�;�4�3���1�H���3�4�5�0�D�;�C
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3. Configuring the Arduino Envir onment
�)�7�4�2�>�=�5�8�6�D�A�0�C�8�>�=�8�=�B�C�A�D�2�C�8�>�=�B�8�=�C�7�8�B�B�4�2�C�8�>�=�4�G�?�;�0�8�=�7�>�F�C�>�0�;�C�4�A�C�7�4���A�3�D�8�=�>������ �B�>�C�7�0�C�8�C�?�A�>�6�A�0�<�B�H�>�D�A
�$�A�0�=�6�D�C�0�=�>�A���?�8�A�>�1�>�C�D�B�8�=�6�C�7�4�2�>�A�A�4�2�C�B�4�C�C�8�=�6�B���D�B�8�=�6�4�8�C�7�4�A�0�=�� �+�' ���(�%�?�A�>�6�A�0�<�<�4�A�C�7�0�C�B�D�?�?�>�A�C�B�C�7�4�0�E�A�8�B�?�E�

�?�A�>�C�>�2�>�;���B�D�2�7�0�B�C�7�4Pololu USB AVR Programmer [http://www .pololu.com/catalog/product/1300]�� �>�A�0�=���A�3�D�8�=�>
�1�>�>�C�;�>�0�3�4�A�	

���	 ���> �C�>http://www.arduino.cc/en/Main/Software [http://www .arduino.cc/en/Main/Software] �0�=�3�3�>�F�=�;�>�0�3�C�7�4
�;�0�C�4�B�C�����A�3�D�8�=�>���B�>�5�C�F�0�A�4���5�>�A���H�>�D�A���?�;�0�C�5�>�A�<�������A�3�D�8�=�>�����	���	�����0�B���>�5���C�7�8�B���F�A�8�C�8�=�6���	

�
�	
���3�3���C�7�4���5�>�;�;�>�F�8�=�6���C�>���C�7�4���4�=�3���>�5���C�7�4boards.txt �5�8�;�4���8�=���C�7�4arduino-1.0.1/hardware/arduino �3�8�A�4�2�C�>�A�H��

##############################################################

orangutan48pgm.name=Pololu Baby Orangutan B-48 via Programmer

orangutan48pgm.upload.using=avrispv2
orangutan48pgm.upload.maximum_size=4096

orangutan48pgm.build.mcu=atmega48
orangutan48pgm.build.f_cpu=20000000L
orangutan48pgm.build.core=arduino
orangutan48pgm.build.variant=standard

##############################################################

orangutan168pgm.name=Pololu Orangutan or 3pi robot w/ ATmega168 via Programmer

orangutan168pgm.upload.using=avrispv2
orangutan168pgm.upload.maximum_size=16384

orangutan168pgm.build.mcu=atmega168
orangutan168pgm.build.f_cpu=20000000L
orangutan168pgm.build.core=arduino
orangutan168pgm.build.variant=standard

##############################################################

orangutan328pgm.name=Pololu Orangutan or 3pi robot w/ ATmega328P via Programmer

orangutan328pgm.upload.using=avrispv2
orangutan328pgm.upload.maximum_size=32768

orangutan328pgm.build.mcu=atmega328p
orangutan328pgm.build.f_cpu=20000000L
orangutan328pgm.build.core=arduino
orangutan328pgm.build.variant=standard

�)�7�8�B���F�8�;�;���0�3�3���C�7�A�4�4���>�?�C�8�>�=�B���C�>���C�7�4Tools > Board�<�4�=�D���>�5���C�7�4�����A�3�D�8�=�>���������	

If you would rather use a differ ent programmer that does not support the avrispv2
protocol���C�7�4�=�2�7�0�=�6�4�C�7�4upload.using�;�8�=�4�B�C�>�<�0�C�2�7�C�7�4�=�0�<�4�>�5�H�>�D�A�?�A�>�6�A�0�<�<�4�A�
�?�A�>�C�>�2�>�;��
�0�=�3�B�:�8�?�(�C�4�?�� ���8�5�H�>�D�A�?�A�>�6�A�0�<�<�4�A�8�B�0�;�A�4�0�3�H�3�4�5�8�=�4�3�1�H�C�7�4���A�3�D�8�=�>�4�=�E�8�A�>�=�<�4�=�C���>�A�0�3�3�C�7�4
�2�>�A�A�4�B�?�>�=�3�8�=�6���4�=�C�A�H���5�>�A���H�>�D�A���?�A�>�6�A�0�<�<�4�A���8�=programmers.txt�	

�)�7�4�B�4�=�4�G�C�C�F�>�4�=�C�A�8�4�B�0�A�4�>�?�C�8�>�=�0�;���1�D�C�0�;�;�>�F�H�>�D�C�>�D�B�4�0�=���A�3�D�8�=�>�1�>�>�C�;�>�0�3�4�A�8�=�B�C�4�0�3�>�5�0�=�4�G�C�4�A�=�0�;
�?�A�>�6�A�0�<�<�4�A��

##############################################################

orangutan168.name=Pololu Orangutan or 3pi robot w/ ATmega168 via Bootloader

orangutan168.upload.protocol=arduino
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orangutan168.upload.maximum_size=15872
orangutan168.upload.speed=144000

orangutan168.bootloader.low_fuses=0xF6
orangutan168.bootloader.high_fuses=0xDD
orangutan168.bootloader.extended_fuses=0x04
orangutan168.bootloader.path=optiboot
orangutan168.bootloader.file=optiboot_atmega168.hex
orangutan168.bootloader.unlock_bits=0x3F
orangutan168.bootloader.lock_bits=0x0F

orangutan168.build.mcu=atmega168
orangutan168.build.f_cpu=20000000L
orangutan168.build.core=arduino
orangutan168.build.variant=standard

##############################################################

orangutan328.name=Pololu Orangutan or 3pi robot w/ ATmega328P via Bootloader

orangutan328.upload.protocol=arduino
orangutan328.upload.maximum_size=32256
orangutan328.upload.speed=144000

orangutan328.bootloader.low_fuses=0xF6
orangutan328.bootloader.high_fuses=0xDE
orangutan328.bootloader.extended_fuses=0x05
orangutan328.bootloader.path=optiboot
orangutan328.bootloader.file=optiboot_atmega328.hex
orangutan328.bootloader.unlock_bits=0x3F
orangutan328.bootloader.lock_bits=0x0F

orangutan328.build.mcu=atmega328p
orangutan328.build.f_cpu=20000000L
orangutan328.build.core=arduino
orangutan328.build.variant=standard

If you want to usethe bootloader���H�>�D�F�8�;�;�B�C�8�;�;�=�4�4�3�C�>�D�B�4�0�=�� �+�' �?�A�>�6�A�0�<�<�4�A�C�>�8�=�8�C�8�0�;�;�H
�;�>�0�3�C�7�4�1�>�>�C�;�>�0�3�4�A�>�=�C�>�H�>�D�A�$�A�0�=�6�D�C�0�=�>�A���?�8���0�=�3�H�>�D�F�8�;�;�0�;�B�>�=�4�4�3�C�>�>�1�C�0�8�=�0�*�(�����C�>���B�4�A�8�0�;
�0�3�0�?�C�4�A�>�A�'�(���
���
���C�>���)�)�!�B�4�A�8�0�;�0�3�0�?�C�4�A�C�7�A�>�D�6�7�F�7�8�2�7�C�7�4���A�3�D�8�=�>�B�>�5�C�F�0�A�4�2�0�=�C�0�;�:�C�>�C�7�4
���A�3�D�8�=�>�1�>�>�C�;�>�0�3�4�A�>�=�H�>�D�A�3�4�E�8�2�4�	�)�7�4�%�>�;�>�;�D�*�(�� �� �+�' �%�A�>�6�A�0�<�<�4�A�2�0�=�B�4�A�E�4�0�B�H�>�D�A�� �+�'
���(�%���?�A�>�6�A�0�<�<�4�A���0�=�3���*�(�����C�>���B�4�A�8�0�;���0�3�0�?�C�4�A�	

�#�>�C�4�C�7�0�C�H�>�D�F�8�;�;�7�0�E�4�C�>�4�8�C�7�4�A�A�4�B�4�C�C�7�4�$�A�0�=�6�D�C�0�=�
���?�8�<�0�=�D�0�;�;�H�F�7�4�=�?�A�>�6�A�0�<�<�8�=�6�8�C
�F�8�C�7�C�7�4�1�>�>�C�;�>�0�3�4�A�>�A�<�>�3�8�5�H�C�7�4�7�0�A�3�F�0�A�4�C�>�0�;�;�>�F�C�7�4���)�' �2�>�=�C�A�>�;�B�8�6�=�0�;�C�>�0�D�C�>���A�4�B�4�C�C�7�4
�<�8�2�A�>�2�>�=�C�A�>�;�;�4�A�	

���4 �0�F�0�A�4�C�7�0�C�C�7�4���0�1�H�$�A�0�=�6�D�C�0�=����48 �7�0�B�0�=�� �)�<�4�6�0�����<�8�2�A�>�2�>�=�C�A�>�;�;�4�A�� �F�7�8�2�7�;�0�2�:�B�0
�1�>�>�C�;�>�0�3�4�A���B�4�2�C�8�>�=�����<�4�0�=�8�=�6���C�7�4�������������E�4�A�B�8�>�=���2�0�=���>�=�;�H���1�4���?�A�>�6�A�0�<�<�4�3���D�B�8�=�6���0�=�������(�%�	

���	
���5�H�>�D�0�A�4�D�B�8�=�6�0�=�� �+�' ���(�%�?�A�>�6�A�0�<�<�4�A�B�D�2�7�0�B�>�D�A�*�(�� �� �+�' �%�A�>�6�A�0�<�<�4�A���0�3�3�C�7�4�5�>�;�;�>�F�8�=�6�C�>�C�7�4�4�=�3�>�5
�C�7�4programmers.txt �5�8�;�4���8�=���C�7�4arduino-1.0.1/hardware/arduino �3�8�A�4�2�C�>�A�H��

avrispv2.name=AVR ISP v2
avrispv2.communication=serial
avrispv2.protocol=avrispv2

�)�7�8�B���F�8�;�;���0�;�;�>�F���C�7�4�����A�3�D�8�=�>�����������C�>���?�A�>�6�A�0�<���F�8�C�7���C�7�4���0�E�A�8�B�?�E�
���?�A�>�C�>�2�>�;���D�B�4�3���1�H���>�D�A���*�(�������+�'���%�A�>�6�A�0�<�<�4�A�	

Programming Orangutans and the 3pi Robot from the Arduino Environment© 2001Ð2012 Pololu Corporation

3. Configuring the Arduino Environment Page 20 of 60



4. Using the Arduino IDE: Blinking an LED
�#�>�F�8�C�O�B�C�8�<�4�C�>�C�0�:�4�C�7�4���A�3�D�8�=�>������ �5�>�A�0�B�?�8�=�	�$�D�A�5�8�A�B�C�6�>�0�;�F�8�;�;�1�4�C�>�;�>�0�3�0�B�8�<�?�;�4�!�������1�;�8�=�:�8�=�6�B�:�4�C�2�7
�����A�3�D�8�=�>���?�A�>�6�A�0�<�����>�=�C�>���>�D�A���$�A�0�=�6�D�C�0�=���>�A�����?�8�	

Open the Arduino IDE and create the following sketch:

/*
* Blink
*
* The basic Arduino example, modified to work for Orangutans.
* Turns on an LED for one second, then off for one second,
* and so on...  We use pin 1 because Orangutans have an LED
* on PD1, which corresponds to Arduino pin 1.
*
* http://www.arduino.cc/en/Tutorial/Blink
*/

int ledPin = 1;                 // LED connected to digital pin 1 (PD1) on Orangutans

void setup()                    // run once, when the sketch starts
{

pinMode(ledPin, OUTPUT);      // sets the digital pin as output
}

void loop()                     // run over and over again
{

digitalWrite(ledPin, HIGH);   // sets the LED on
delay(1000);                  // waits for a second
digitalWrite(ledPin, LOW);    // sets the LED off
delay(1000);                  // waits for a second

}

���8�C�7�4�A�2�>�?�H�C�7�4�0�1�>�E�4�C�4�G�C�8�=�C�>�0�=�4�F�� �1�;�0�=�:�B�:�4�C�2�7���>�A�3�>�F�=�;�>�0�3�C�7�8�B�B�:�4�C�2�7�0�BOrangutanBlinkExample.pde
[http://www .pololu.com/file/download/OrangutanBlinkExample.pde?file_id=0J95]�����:���?�3�4�����0�=�3���>�?�4�=���8�C���8�=���C�7�4�����A�3�D�8�=�>���������	
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Select one of our specially-created boards using the Tools > Board menu:
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Select the programmer:

���5�H�>�D�0�A�4�D�B�8�=�6�0�%�>�;�>�;�D�*�(�� �� �+�' �%�A�>�6�A�0�<�<�4�A���B�4�;�4�2�C�M���+�' ���(�%�E�
�N�8�=�C�7�4�%�A�>�6�A�0�<�<�4�A�<�4�=�D�	�$�C�7�4�A�F�8�B�4���2�>�=�B�D�;�C
�C�7�4���3�>�2�D�<�4�=�C�0�C�8�>�=���>�5���H�>�D�A���?�A�>�6�A�0�<�<�4�A���C�>���5�8�=�3���>�D�C���F�7�8�2�7���>�?�C�8�>�=���C�>���B�4�;�4�2�C�	

Select the programmerÕs serial port:

���5�H�>�D�0�A�4�D�B�8�=�6�0 �%�>�;�>�;�D�*�(�� �� �+�' �%�A�>�6�A�0�<�<�4�A�� �<�0�:�4�B�D�A�4�H�>�D�7�0�E�4�8�=�B�C�0�;�;�4�3�C�7�4�?�A�>�?�4�A�3�A�8�E�4�A�B���B�4�4�C�7�4
programmerÕs userÕs guide [http://www .pololu.com/docs/0J36]�� �0�=�3�7�0�E�4�2�>�=�=�4�2�C�4�3�8�C�C�>�H�>�D�A�2�>�<�?�D�C�4�A�	 �$�=�2�4�C�7�8�B�8�B
�3�>�=�4���H�>�D�B�7�>�D�;�3�1�4�0�1�;�4�C�>�B�4�4�8�C�B���$�" �?�>�A�C�;�8�B�C�4�3�D�=�3�4�A�C�7�4Tools> Serial Port �<�4�=�D�	���5�H�>�D�3�>�=�O�C�:�=�>�F�F�7�8�2�7
���$�" �?�>�A�C�H�>�D�A�?�A�>�6�A�0�<�<�4�A�8�B�>�=���H�>�D�2�0�=�3�4�C�4�A�<�8�=�4�C�7�8�B�1�H�1�A�8�=�6�8�=�6�D�?�H�>�D�A�2�>�<�?�D�C�4�A�O�B�3�4�E�8�2�4�<�0�=�0�6�4�A�0�=�3
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�4�G�?�0�=�3�8�=�6�C�7�4Ports (COM & LPT) �;�8�B�C�	�)�>�1�A�8�=�6�D�?�C�7�4�3�4�E�8�2�4�<�0�=�0�6�4�A���A�8�6�7�C���2�;�8�2�:�>�=�M�"�H���>�<�?�D�C�4�A�N�0�=�3�B�4�;�4�2�C
Manage���C�7�4�=�2�;�8�2�:�C�7�4DeviceManager �>�?�C�8�>�=�;�8�B�C�4�3�>�=�C�7�4�;�4�5�C�B�8�3�4�D�=�3�4�ASystemTools�	�!�>�>�:�5�>�A�C�7�4�?�>�A�C�C�7�0�C
�B�0�H�B���M�%�>�;�>�;�D���*�(�������+�'���%�A�>�6�A�0�<�<�4�A���%�A�>�6�A�0�<�<�8�=�6���%�>�A�C�N�	

���5�H�>�D�0�A�4�D�B�8�=�6�0�C�A�D�4�*�(�� �?�A�>�6�A�0�<�<�4�A���8�	�4�	�>�=�4�C�7�0�C�3�>�4�B�=�>�C�4�<�D�;�0�C�4�0�B�4�A�8�0�;�?�>�A�C�����H�>�D�B�7�>�D�;�3�=�O�C�=�4�4�3�C�>�B�4�;�4�2�C�0
�B�4�A�8�0�;���?�>�A�C�	

Program your Orangutan or 3pi with the sketch:

���>�=�=�4�2�C�H�>�D�A�?�A�>�6�A�0�<�<�4�A�C�>�C�7�4�$�A�0�=�6�D�C�0�=�>�A���?�8�E�8�0�8�C�B�B�8�G���?�8�=���(�%�7�4�0�3�4�A�� �<�0�:�8�=�6�B�D�A�4�C�7�0�C�?�8�=�� �>�5�C�7�4
�?�A�>�6�A�0�<�<�4�A�;�8�=�4�B�D�?�F�8�C�7�?�8�=�� �>�5�C�7�4�C�0�A�6�4�C�O�B�?�A�>�6�A�0�<�<�8�=�6�7�4�0�3�4�A�	�)�7�4�$�A�0�=�6�D�C�0�=�(�+���G�G�����$�A�0�=�6�D�C�0�=�!�+�����������0�=�3
���?�8�4�0�2�7�7�0�E�4�0�B�7�A�>�D�3�4�3�7�4�0�3�4�A�C�7�0�C�F�8�;�;�4�=�5�>�A�2�4�2�>�A�A�4�2�C�?�8�=�>�A�8�4�=�C�0�C�8�>�=���1�D�C�C�7�4���0�1�H�$�A�0�=�6�D�C�0�=�� �3�>�4�B�=�>�C�	�%�8�=��
�>�=�C�7�4���0�1�H�$�A�0�=�6�D�C�0�=�8�B�<�0�A�:�4�3�1�H�0�2�>�?�?�4�A�0�A�A�>�F�>�=�C�7�4�%�����0�=�3�?�8�=�� �>�=�>�D�A�*�(�� �� �+�' �%�A�>�6�A�0�<�<�4�A�8�B�<�0�A�:�4�3
�1�H���0���A�0�8�B�4�3���?�;�0�B�C�8�2���C�A�8�0�=�6�;�4���>�=���C�7�4�����������2�>�=�=�4�2�C�>�A�	
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5. Arduino Libraries for the Orangutan and 3pi Robot

Note: ���4�2�0�D�B�4�C�7�4�$�A�0�=�6�D�C�0�=�B�F�4�A�4�=�>�C�3�4�B�8�6�=�4�3�0�B�>�5�5�8�2�8�0�;���A�3�D�8�=�>�1�>�0�A�3�B���=�>�C�0�;�;�4�G�8�B�C�8�=�6���A�3�D�8�=�>
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Overview
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apply to the Orangutan will work for the corr esponding hardware on the 3pi robot�	
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unsigned int x;

// C++ function through instantiated object
OrangutanAnalog analog; // this line is usually placed above setup()
x = analog.readTrimpot();

// C++ function through class scope
x = OrangutanAnalog::readTrimpot();

// C function
x = read_trimpot();
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Download Instructions
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Installation

Note: ���5�H�>�D�2�D�A�A�4�=�C�;�H�7�0�E�4�0�=�>�;�3�4�A�E�4�A�B�8�>�=�>�5�>�D�A�%�>�;�>�;�D���A�3�D�8�=�>�!�8�1�A�0�A�8�4�B���H�>�D�A�5�8�A�B�C�B�C�4�?�B�7�>�D�;�3
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���4�2�>�<�?�A�4�B�B�C�7�4�0�A�2�7�8�E�4�0�=�3�<�>�E�4�4�0�2�7�>�5�C�7�4�$�A�0�=�6�D�C�0�=�/�/�/�0�=�3�%�>�;�>�;�D�/�/�/�3�8�A�4�2�C�>�A�8�4�B�F�8�C�7�8�=�C�7�4�;�8�1�?�>�;�>�;�D���0�E�A
�5�>�;�3�4�A�8�=�C�>�C�7�4libraries �B�D�1�3�8�A�4�2�C�>�A�H�8�=�B�8�3�4�H�>�D�A���A�3�D�8�=�>�B�:�4�C�2�7�1�>�>�:�	�. �>�D�2�0�=�E�8�4�F�H�>�D�A�B�:�4�C�2�7�1�>�>�:�;�>�2�0�C�8�>�=�1�H
�B�4�;�4�2�C�8�=�6File > Preferences�8�=�C�7�4���A�3�D�8�=�>�4�=�E�8�A�>�=�<�4�=�C���8�5�C�7�4�A�4�8�B�=�>�C�0�;�A�4�0�3�H�0�M�;�8�1�A�0�A�8�4�B�N�5�>�;�3�4�A�8�=�C�7�0�C�;�>�2�0�C�8�>�=��
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�2�0�=�B�4�;�4�2�CSketch> Import Library > OrangutanBuzzer �5�A�>�<�H�>�D�A���A�3�D�8�=�>�������� �>�A�H�>�D�2�0�=�B�8�<�?�;�H�C�H�?�4#include
<OrangutanBuzzer.h> �0�C�C�7�4�C�>�?�>�5�H�>�D�A�B�:�4�C�2�7�	�#�>�C�4�C�7�0�C�H�>�D�<�8�6�7�C�=�4�4�3�C�>�A�4�B�C�0�A�C�H�>�D�A���A�3�D�8�=�>������ �1�4�5�>�A�4�8�C
�B�4�4�B�C�7�4�=�4�F�;�8�1�A�0�A�8�4�B�	���5�H�>�D�3�>�=�>�C�=�4�4�3�C�7�4�5�D�=�2�C�8�>�=�0�;�8�C�H�>�5�0�B�?�4�2�8�5�8�2�;�8�1�A�0�A�H���H�>�D�B�7�>�D�;�3�;�4�0�E�4�8�C�>�D�C�>�5�H�>�D�A�B�:�4�C�2�7
���B�8�<�?�;�H�3�4�;�4�C�4�C�7�4#include �;�8�=�4�0�B�B�>�2�8�0�C�4�3�F�8�C�7�8�C�5�A�>�<�C�7�4�C�>�?�>�5�H�>�D�A�B�:�4�C�2�7�8�5�H�>�D�O�E�4�0�;�A�4�0�3�H�0�3�3�4�3�8�C���	���=�2�;�D�3�4�3
�;�8�1�A�0�A�8�4�B���F�8�;�;���C�0�:�4���D�?���?�A�>�6�A�0�<���B�?�0�2�4�����4�E�4�=���8�5���H�>�D���3�>�=�O�C���D�B�4���C�7�4�<���8�=���H�>�D�A���?�A�>�6�A�0�<�	
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Usage Examples
�"�>�B�C�;�8�1�A�0�A�8�4�B�2�>�<�4�F�8�C�7�0�C�;�4�0�B�C�>�=�4�4�G�0�<�?�;�4�B�:�4�C�2�7�C�7�0�C�3�4�<�>�=�B�C�A�0�C�4�B�7�>�F�C�7�4�;�8�1�A�0�A�H�2�0�=�1�4�D�B�4�3�	�)�>�;�>�0�3�0�=
�4�G�0�<�?�;�4���B�:�4�C�2�7�����>�?�4�=���C�7�4�����A�3�D�8�=�>�����������0�=�3���6�>���C�>File > Examples > Orangutan____�	

�)�7�4�%�>�;�>�;�D���?�8�;�8�1�A�0�A�H�2�>�<�4�B�F�8�C�7�B�4�E�4�A�0�;�3�4�C�0�8�;�4�3�;�8�=�4���5�>�;�;�>�F�8�=�6�0�=�3�<�0�I�4���B�>�;�E�8�=�6�4�G�0�<�?�;�4�B�:�4�C�2�7�4�B�C�7�0�C�2�0�=�1�4
�;�>�0�3�4�3���D�B�8�=�6File > Examples > Pololu3pi�	

5.a.OrangutanAnalog - Analog Input Library
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Overview
�)�7�8�B�;�8�1�A�0�A�H�?�A�>�E�8�3�4�B�0�B�4�C�>�5�<�4�C�7�>�3�B�C�7�0�C�2�0�=�1�4�D�B�4�3�C�>�A�4�0�3�0�=�0�;�>�6�E�>�;�C�0�6�4�8�=�?�D�C�B���0�B�F�4�;�;�0�B�5�D�=�2�C�8�>�=�B�B�?�4�2�8�5�8�2�0�;�;�H
�3�4�B�8�6�=�4�3�C�>�A�4�0�3�C�7�4�E�0�;�D�4�>�5�C�7�4�C�A�8�<�<�4�A�?�>�C�4�=�C�8�>�<�4�C�4�A���>�=�C�7�43pi robot [http://www .pololu.com/catalog/product/975]��
Orangutan SV-xx8 [http://www .pololu.com/catalog/product/1227]��Orangutan LV-168[http://www .pololu.com/catalog/product/

775]�� �0�=�3Baby Orangutan B [http://www .pololu.com/catalog/product/1220]�����C�7�4�1�0�C�C�4�A�H�E�>�;�C�0�6�4�;�4�E�4�;�8�=�<�8�;�;�8�E�>�;�C�B�����?�8
�A�>�1�>�C���(�+���G�G�������0�=�3�C�7�4�E�0�;�D�4�>�5�C�7�4�C�4�<�?�4�A�0�C�D�A�4�B�4�=�B�>�A�8�=�C�4�=�C�7�B�>�5�0�3�4�6�A�4�4�� �>�A�� ���>�=�C�7�4�$�A�0�=�6�D�C�0�=�!�+���������>�=�;�H���	
�)�7�8�B���;�8�1�A�0�A�H���6�8�E�4�B���H�>�D���<�>�A�4���2�>�=�C�A�>�;���C�7�0�=���4�G�8�B�C�8�=�6�����A�3�D�8�=�>���0�=�0�;�>�6���8�=�?�D�C���5�D�=�2�C�8�>�=�B�	

�. �>�D�3�>�=�>�C�=�4�4�3�C�>�8�=�8�C�8�0�;�8�I�4�H�>�D�A�$�A�0�=�6�D�C�0�=���=�0�;�>�6�>�1�9�4�2�C�1�4�5�>�A�4�D�B�4�	���;�;�8�=�8�C�8�0�;�8�I�0�C�8�>�=�8�B�?�4�A�5�>�A�<�4�3�0�D�C�>�<�0�C�8�2�0�;�;�H
�F�7�4�=���=�4�4�3�4�3�	

���;�;�>�5�C�7�4�<�4�C�7�>�3�B�8�=�C�7�8�B�2�;�0�B�B�0�A�4�B�C�0�C�8�2���H�>�D�B�7�>�D�;�3�=�4�E�4�A�7�0�E�4�<�>�A�4�C�7�0�=�>�=�4�8�=�B�C�0�=�2�4�>�5�0�=�$�A�0�=�6�D�C�0�=���=�0�;�>�6
�>�1�9�4�2�C���8�=���H�>�D�A���B�:�4�C�2�7�	
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OrangutanAnalog Methods
���>�<�?�;�4�C�4�3�>�2�D�<�4�=�C�0�C�8�>�=�>�5�C�7�8�B�;�8�1�A�0�A�H�O�B�<�4�C�7�>�3�B�2�0�=�1�4�5�>�D�=�3�8�=Section2 �>�5�C�7�4Pololu AVR Library Command
Reference[http://www .pololu.com/docs/0J18]�	
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Usage Examples
�)�7�8�B�;�8�1�A�0�A�H�2�>�<�4�B�F�8�C�7�C�F�>�4�G�0�<�?�;�4�B�:�4�C�2�7�4�B�C�7�0�C�H�>�D�2�0�=�;�>�0�3�1�H�6�>�8�=�6�C�>File > Examples> OrangutanAnalog�	
�)�7�4���4�G�0�<�?�;�4���B�:�4�C�2�7�4�B���C�7�0�C���2�>�<�4���F�8�C�7���C�7�4OrangutanMotors �;�8�1�A�0�A�H���0�;�B�>���<�0�:�4���;�8�<�8�C�4�3���D�B�4���>�5���C�7�8�B���;�8�1�A�0�A�H�	

1. OrangutanAnalogExample

���4�<�>�=�B�C�A�0�C�4�B�7�>�F�H�>�D�2�0�=�D�B�4�C�7�4�<�4�C�7�>�3�B�8�=�C�7�8�B�;�8�1�A�0�A�H�C�>�A�4�0�3�C�7�4�0�=�0�;�>�6�E�>�;�C�0�6�4�>�5�C�7�4�C�A�8�<�<�4�A�?�>�C�4�=�C�8�>�<�4�C�4�A
�8�=�C�7�4�1�0�2�:�6�A�>�D�=�3�F�7�8�;�4�C�7�4�A�4�B�C�>�5�H�>�D�A�2�>�3�4�4�G�4�2�D�C�4�B�	���5�C�7�4������ �8�B�5�A�4�4���C�7�4�?�A�>�6�A�0�<�B�C�0�A�C�B�0�2�>�=�E�4�A�B�8�>�=�>�=
�C�7�4�)�'���"�%�$�) �0�=�0�;�>�6�8�=�?�D�C���2�7�0�=�=�4�;�������0�=�3�C�7�4�=�8�C�?�A�>�2�4�4�3�B�C�>�4�G�4�2�D�C�4�C�7�4�A�4�B�C�>�5�C�7�4�2�>�3�4�8�=�;�>�>�?�����F�7�8�;�4�C�7�4
������ �7�0�A�3�F�0�A�4�F�>�A�:�B�	�%�>�;�;�8�=�6�>�5�C�7�4�8�B���>�=�E�4�A�C�8�=�6�����<�4�C�7�>�3�0�;�;�>�F�B�C�7�4�?�A�>�6�A�0�<�C�>�3�4�C�4�A�<�8�=�4�F�7�4�=�C�7�4�2�>�=�E�4�A�B�8�>�=
�8�B�2�>�<�?�;�4�C�4�0�=�3�C�>�D�?�3�0�C�4�8�C�B�=�>�C�8�>�=�>�5�C�7�4�C�A�8�<�?�>�C�E�0�;�D�4�0�2�2�>�A�3�8�=�6�;�H�	���4�4�3�1�0�2�:�8�B�6�8�E�4�=�E�8�0�C�7�4�A�4�3�D�B�4�A�!������ �F�7�>�B�4
�1�A�8�6�7�C�=�4�B�B���8�B���<�0�3�4���C�>���B�2�0�;�4���F�8�C�7���C�7�4���C�A�8�<�?�>�C���?�>�B�8�C�8�>�=�	

#include <OrangutanLEDs.h>
#include <OrangutanAnalog.h>

/*
* OrangutanAnalogExample for the 3pi, Orangutan SV-xx8,
*    Orangutan LV-168, or Baby Orangutan B
*
* This sketch uses the OrangutanAnalog library to read the voltage output
* of the trimpot in the background while the rest of the main loop executes.
* The LED is flashed so that its brightness appears proportional to the
* trimpot position.
*
* http://www.pololu.com/docs/0J17/5.a
* http://www.pololu.com
* http://forum.pololu.com
*/

OrangutanLEDs leds;
OrangutanAnalog analog;

unsigned int sum;
unsigned int avg;
unsigned char samples;

void setup()                      // run once, when the sketch starts
{

analog.setMode(MODE_8_BIT);    // 8-bit analog-to-digital conversions
sum = 0;
samples = 0;
avg = 0;
analog.startConversion(TRIMPOT);  // start initial conversion

}

void loop()                       // run over and over again
{

if (!analog.isConverting())     // if conversion is done...
{

sum += analog.conversionResult();  // get result
analog.startConversion(TRIMPOT);          // and start next conversion
if (++samples == 20)
{

avg = sum / 20;             // compute 20-sample average of ADC result
samples = 0;
sum = 0;

}
}

// when avg == 0, the red LED is almost totally off
// when avg == 255, the red LED is almost totally on
// brightness should scale approximately linearly in between
leds.red(LOW);                  // red LED off
delayMicroseconds(256 - avg);
leds.red(HIGH);                 // red LED on
delayMicroseconds(avg + 1);

}
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2. OrangutanAnalogExample2

���=�C�4�=�3�4�3�5�>�A�D�B�4�>�=�C�7�4�$�A�0�=�6�D�C�0�=�!�+���������	�#�>�C�4�C�7�0�C�8�C�F�8�;�;�A�D�=�>�=�C�7�4���?�8�A�>�1�>�C�0�=�3�$�A�0�=�6�D�C�0�=�(�+���G�G�����1�D�C�C�7�4
�3�8�B�?�;�0�H�4�3�C�4�<�?�4�A�0�C�D�A�4�F�8�;�;�1�4�8�=�2�>�A�A�4�2�C�0�B�C�7�4�0�=�0�;�>�6�8�=�?�D�C�2�>�=�=�4�2�C�4�3�C�>�C�7�4�C�4�<�?�4�A�0�C�D�A�4�B�4�=�B�>�A�>�=�C�7�4�$�A�0�=�6�D�C�0�=
�!�+�������� �8�B�2�>�=�=�4�2�C�4�3�C�>�
�
���A�3�B�>�5�C�7�4�1�0�C�C�4�A�H�E�>�;�C�0�6�4�>�=�C�7�4���?�8�0�=�3�C�>���
���A�3�>�5�C�7�4�1�0�C�C�4�A�H�E�>�;�C�0�6�4�>�=�C�7�4�$�A�0�=�6�D�C�0�=
�(�+���G�G���	���C�3�8�B�?�;�0�H�B�>�=�C�7�4�!���� �C�7�4�C�A�8�<�<�4�A�?�>�C�4�=�C�8�>�<�4�C�4�A�>�D�C�?�D�C�8�=�<�8�;�;�8�E�>�;�C�B�0�=�3�C�7�4�C�4�<�?�4�A�0�C�D�A�4�B�4�=�B�>�A�>�D�C�?�D�C
�8�=�3�4�6�A�4�4�B���0�7�A�4�=�7�4�8�C�	���5�H�>�D�7�>�;�3�0�5�8�=�6�4�A�>�=�C�7�4�D�=�3�4�A�B�8�3�4�>�5�C�7�4�$�A�0�=�6�D�C�0�=�!�+���������O�B�%�����=�4�0�A�C�7�4�2�4�=�C�4�A�>�5�C�7�4
�1�>�0�A�3���H�>�D�B�7�>�D�;�3�B�4�4�C�7�4�C�4�<�?�4�A�0�C�D�A�4�A�4�0�3�8�=�6�B�;�>�F�;�H�B�C�0�A�C�C�>�A�8�B�4�	���4�2�0�A�4�5�D�;�=�>�C�C�>�I�0�?�C�7�4�1�>�0�A�3�F�8�C�7�4�;�4�2�C�A�>�B�C�0�C�8�2
�3�8�B�2�7�0�A�6�4���8�5���H�>�D���C�A�H���C�7�8�B��

#include <OrangutanLCD.h>
#include <OrangutanAnalog.h>

/*
* OrangutanAnalogExample2: for the Orangutan LV-168
*
* This sketch uses the OrangutanAnalog library to read the voltage output
* of the trimpot (in millivolts) and to read the Orangutan LV-168's
* temperature sensor in degrees Farenheit.  These values are printed to
* the LCD 10 times per second.  This example is intended for use with the
* Orangutan LV-168, though all but the temperature-measuring portion
* will work on the 3pi robot (on the 3pi, analog input 6 connects to 2/3rds
* of the battery voltage rather than a temperature sensor) and the
* Orangutan SV-xx8 (on the SV-xx8, analog input 6 connects to 1/3rd of
* the battery voltage).
*
* You should see the trimpot voltage change as you turn it, and you can
* get the temperature reading to slowly increase by holding a finger on the
* underside of the Orangutan LV-168's PCB near the center of the board.
* Be careful not to zap the board with electrostatic discharge if you
* try this!
*/

OrangutanLCD lcd;
OrangutanAnalog analog;

void setup()                      // run once, when the sketch starts
{

analog.setMode(MODE_10_BIT);    // 10-bit analog-to-digital conversions
}

void loop()                       // run over and over again
{

lcd.gotoXY(0,0);                // LCD cursor to home position (upper-left)
lcd.print(analog.toMillivolts(analog.readTrimpot()));  // trimpot output in mV
lcd.print(" mV  ");             // added spaces are to overwrite left over chars

lcd.gotoXY(0, 1);               // LCD cursor to start of the second line

// get temperature in tenths of a degree F
unsigned int temp = analog.readTemperatureF();
lcd.print(temp/10);             // get the whole number of degrees
lcd.print('.');                 // print the decimal point
lcd.print(temp - (temp/10)*10); // print the tenths digit
lcd.print((char)223);           // print a degree symbol
lcd.print("F  ");               // added spaces are to overwrite left over chars

delay(100);                     // wait for 100 ms (reduces LCD flicker)
}

5.b.OrangutanBuzzer - High-Level Buzzer Control Library
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Overview
�)�7�8�B�;�8�1�A�0�A�H�0�;�;�>�F�B�H�>�D�C�>�4�0�B�8�;�H�2�>�=�C�A�>�;�C�7�4�?�8�4�I�>�1�D�I�I�4�A�>�=�C�7�43pi robot [http://www .pololu.com/catalog/product/975]��
Orangutan SV-xx8 [http://www .pololu.com/catalog/product/1227]�� �0�=�3Orangutan LV-168 [http://www .pololu.com/catalog/

product/775]�	 ���C�6�8�E�4�B�H�>�D�C�7�4�>�?�C�8�>�=�>�5�?�;�0�H�8�=�6�4�8�C�7�4�A�0�=�>�C�4�>�A�0�5�A�4�@�D�4�=�2�H�5�>�A�0�B�?�4�2�8�5�8�4�3�3�D�A�0�C�8�>�=�0�C�0�B�?�4�2�8�5�8�4�3
�E�>�;�D�<�4���>�A�H�>�D�2�0�=�D�B�4�C�7�4play() �<�4�C�7�>�3�C�>�?�;�0�H�0�=�4�=�C�8�A�4�<�4�;�>�3�H�8�=�C�7�4�1�0�2�:�6�A�>�D�=�3�	���D�I�I�4�A�2�>�=�C�A�>�;�8�B�0�2�7�8�4�E�4�3
�D�B�8�=�6�>�=�4�>�5�C�7�4�)�8�<�4�A���%�,�" �>�D�C�?�D�C�B���0�=�3�3�D�A�0�C�8�>�=�C�8�<�8�=�6�8�B�?�4�A�5�>�A�<�4�3�D�B�8�=�6�0�)�8�<�4�A���>�E�4�A�5�;�>�F�8�=�C�4�A�A�D�?�C���B�>
this library will conflict with any other libraries that rely on or reconfigure Timer1�	���>�A�4�G�0�<�?�;�4���C�7�4���A�3�D�8�=�>
�5�D�=�2�C�8�>�=analogWrite() �F�8�;�;�=�>�C�F�>�A�:�>�=�C�7�4�)�8�<�4�A���%�,�" �>�D�C�?�D�C�?�8�=�B�>�=�2�4�H�>�D�7�0�E�4�B�C�0�A�C�4�3�C�>�D�B�4�C�7�8�B�;�8�1�A�0�A�H�8�=
�H�>�D�A���B�:�4�C�2�7�	

�)�7�4�1�4�=�4�5�8�C�C�>�C�7�8�B�0�?�?�A�>�0�2�7�8�B�C�7�0�C�H�>�D�2�0�=�?�;�0�H�=�>�C�4�B�>�=�C�7�4�1�D�I�I�4�A�F�7�8�;�4�;�4�0�E�8�=�6�C�7�4���%�*�<�>�B�C�;�H�5�A�4�4�C�>�4�G�4�2�D�C�4
�C�7�4�A�4�B�C�>�5�H�>�D�A�2�>�3�4�	�)�7�8�B�<�4�0�=�B�H�>�D�2�0�=�7�0�E�4�0�<�4�;�>�3�H�?�;�0�H�8�=�6�8�=�C�7�4�1�0�2�:�6�A�>�D�=�3�F�7�8�;�4�H�>�D�A�$�A�0�=�6�D�C�0�=�>�A���?�8
�3�>�4�B���8�C�B���<�0�8�=���C�0�B�:�	���.�>�D���2�0�=���?�>�;�;���C�7�4isPlaying() �<�4�C�7�>�3���C�>���3�4�C�4�A�<�8�=�4���F�7�4�=���C�7�4���1�D�I�I�4�A���8�B���5�8�=�8�B�7�4�3���?�;�0�H�8�=�6�	

�. �>�D�3�>�=�>�C�=�4�4�3�C�>�8�=�8�C�8�0�;�8�I�4�H�>�D�A�$�A�0�=�6�D�C�0�=���D�I�I�4�A�>�1�9�4�2�C�1�4�5�>�A�4�D�B�4�	���;�;�8�=�8�C�8�0�;�8�I�0�C�8�>�=�8�B�?�4�A�5�>�A�<�4�3�0�D�C�>�<�0�C�8�2�0�;�;�H
�F�7�4�=���=�4�4�3�4�3�	

���;�;�>�5�C�7�4�<�4�C�7�>�3�B�8�=�C�7�8�B�2�;�0�B�B�0�A�4�B�C�0�C�8�2���H�>�D�B�7�>�D�;�3�=�4�E�4�A�7�0�E�4�<�>�A�4�C�7�0�=�>�=�4�8�=�B�C�0�=�2�4�>�5�0�=�$�A�0�=�6�D�C�0�=���D�I�I�4�A
�>�1�9�4�2�C���8�=���H�>�D�A���B�:�4�C�2�7�	
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OrangutanBuzzer Methods
���>�<�?�;�4�C�4�3�>�2�D�<�4�=�C�0�C�8�>�=�>�5�C�7�8�B�;�8�1�A�0�A�H�O�B�<�4�C�7�>�3�B�2�0�=�1�4�5�>�D�=�3�8�=Section3 �>�5�C�7�4Pololu AVR Library Command
Reference[http://www .pololu.com/docs/0J18]�	
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Usage Examples
�)�7�8�B�;�8�1�A�0�A�H�2�>�<�4�B�F�8�C�7�C�7�A�4�4�4�G�0�<�?�;�4�B�:�4�C�2�7�4�B�C�7�0�C�H�>�D�2�0�=�;�>�0�3�1�H�6�>�8�=�6�C�>File > Examples> OrangutanBuzzer�	

1. OrangutanBuzzerExample

���4�<�>�=�B�C�A�0�C�4�B�>�=�4�F�0�H�C�>�D�B�4�C�7�8�B�;�8�1�A�0�A�H�O�BplayNote() �<�4�C�7�>�3�C�>�?�;�0�H�0�B�8�<�?�;�4�<�4�;�>�3�H�B�C�>�A�4�3�8�=�'���"�	 ���C�B�7�>�D�;�3
�8�<�<�4�3�8�0�C�4�;�H�B�C�0�A�C�?�;�0�H�8�=�6�C�7�4�<�4�;�>�3�H���0�=�3�H�>�D�2�0�=�D�B�4�C�7�4�C�>�?�D�B�4�A�?�D�B�7�1�D�C�C�>�=�C�>�B�C�>�?�0�=�3�A�4�?�;�0�H�C�7�4�<�4�;�>�3�H�	�)�7�4
�4�G�0�<�?�;�4�8�B�B�C�A�D�2�C�D�A�4�3�B�>�C�7�0�C�H�>�D�2�0�=�0�3�3�H�>�D�A�>�F�=�2�>�3�4�C�>loop() �0�=�3�C�7�4�<�4�;�>�3�H�F�8�;�;�B�C�8�;�;�?�;�0�H�=�>�A�<�0�;�;�H�8�=�C�7�4
�1�0�2�:�6�A�>�D�=�3���0�B�B�D�<�8�=�6�H�>�D�A�2�>�3�4�4�G�4�2�D�C�4�B�@�D�8�2�:�;�H�4�=�>�D�6�7�C�>�0�E�>�8�3�8�=�B�4�A�C�8�=�6�3�4�;�0�H�B�1�4�C�F�4�4�=�C�7�4�=�>�C�4�B�	�. �>�D�2�0�=�D�B�4
�C�7�8�B�B�0�<�4�C�4�2�7�=�8�@�D�4�C�>�?�;�0�H�<�4�;�>�3�8�4�B�C�7�0�C�7�0�E�4�1�4�4�=�B�C�>�A�4�3�8�=�����%�'�$�" ���C�7�4�<�4�6�0�������7�0�B�4�=�>�D�6�7�A�>�>�<�8�=�����%�'�$�"
�C�>���B�C�>�A�4�����������=�>�C�4�B���	

#include <OrangutanLCD.h>
#include <OrangutanPushbuttons.h>
#include <OrangutanBuzzer.h>

/*
* OrangutanBuzzerExample: for the Orangutan SV-xx8, Orangutan LV-168,
*    and 3pi robot
*
* This example uses the OrangutanBuzzer library to play a series of notes on
* the buzzer.  It also uses the OrangutanLCD library to display the notes it is
* playing, and it uses the OrangutanPushbuttons library to allow the user to
* stop/reset the melody with the top pushbutton.
*
* http://www.pololu.com/docs/0J17/5.b
* http://www.pololu.com
* http://forum.pololu.com
*/

#define MELODY_LENGTH 95

// These arrays take up a total of 285 bytes of RAM (out of a 1k limit)
unsigned char note[MELODY_LENGTH] =
{

NOTE_E(5), SILENT_NOTE, NOTE_E(5), SILENT_NOTE,
NOTE_E(5), SILENT_NOTE, NOTE_C(5), NOTE_E(5),
NOTE_G(5), SILENT_NOTE, NOTE_G(4), SILENT_NOTE,

NOTE_C(5), NOTE_G(4), SILENT_NOTE, NOTE_E(4), NOTE_A(4),
NOTE_B(4), NOTE_B_FLAT(4), NOTE_A(4), NOTE_G(4),
NOTE_E(5), NOTE_G(5), NOTE_A(5), NOTE_F(5), NOTE_G(5),
SILENT_NOTE, NOTE_E(5), NOTE_C(5), NOTE_D(5), NOTE_B(4),

NOTE_C(5), NOTE_G(4), SILENT_NOTE, NOTE_E(4), NOTE_A(4),
NOTE_B(4), NOTE_B_FLAT(4), NOTE_A(4), NOTE_G(4),
NOTE_E(5), NOTE_G(5), NOTE_A(5), NOTE_F(5), NOTE_G(5),
SILENT_NOTE, NOTE_E(5), NOTE_C(5), NOTE_D(5), NOTE_B(4),

SILENT_NOTE, NOTE_G(5), NOTE_F_SHARP(5), NOTE_F(5),
NOTE_D_SHARP(5), NOTE_E(5), SILENT_NOTE, NOTE_G_SHARP(4),
NOTE_A(4), NOTE_C(5), SILENT_NOTE, NOTE_A(4), NOTE_C(5), NOTE_D(5),

SILENT_NOTE, NOTE_G(5), NOTE_F_SHARP(5), NOTE_F(5),
NOTE_D_SHARP(5), NOTE_E(5), SILENT_NOTE,
NOTE_C(6), SILENT_NOTE, NOTE_C(6), SILENT_NOTE, NOTE_C(6),

SILENT_NOTE, NOTE_G(5), NOTE_F_SHARP(5), NOTE_F(5),
NOTE_D_SHARP(5), NOTE_E(5), SILENT_NOTE,
NOTE_G_SHARP(4), NOTE_A(4), NOTE_C(5), SILENT_NOTE,
NOTE_A(4), NOTE_C(5), NOTE_D(5),

SILENT_NOTE, NOTE_E_FLAT(5), SILENT_NOTE, NOTE_D(5), NOTE_C(5)
};

unsigned int duration[MELODY_LENGTH] =
{

100, 25, 125, 125, 125, 125, 125, 250, 250, 250, 250, 250,

375, 125, 250, 375, 250, 250, 125, 250, 167, 167, 167, 250, 125, 125,
125, 250, 125, 125, 375,
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375, 125, 250, 375, 250, 250, 125, 250, 167, 167, 167, 250, 125, 125,
125, 250, 125, 125, 375,

250, 125, 125, 125, 250, 125, 125, 125, 125, 125, 125, 125, 125, 125,

250, 125, 125, 125, 250, 125, 125, 200, 50, 100, 25, 500,

250, 125, 125, 125, 250, 125, 125, 125, 125, 125, 125, 125, 125, 125,

250, 250, 125, 375, 500
};

OrangutanLCD lcd;
OrangutanPushbuttons buttons;
OrangutanBuzzer buzzer;
unsigned char currentIdx;

void setup()                    // run once, when the sketch starts
{

currentIdx = 0;
lcd.print("Music!");

}

void loop()                     // run over and over again
{

// if we haven't finished playing the song and
// the buzzer is ready for the next note, play the next note
if (currentIdx < MELODY_LENGTH && !buzzer.isPlaying())
{

// play note at max volume
buzzer.playNote(note[currentIdx], duration[currentIdx], 15);

// optional LCD feedback (for fun)
lcd.gotoXY(0, 1);                           // go to start of the second LCD line
lcd.print((unsigned int)note[currentIdx]);  // print integer value of current note
lcd.print("  ");                            // overwrite any left over characters
currentIdx++;

}

// Insert some other useful code here...
// the melody will play normally while the rest of your code executes
// as long as it executes quickly enough to keep from inserting delays
// between the notes.

// For example, let the top user pushbutton function as a stop/reset melody button
if (buttons.isPressed(TOP_BUTTON))
{

buzzer.stopPlaying(); // silence the buzzer
if (currentIdx < MELODY_LENGTH)

currentIdx = MELODY_LENGTH;        // terminate the melody
else

currentIdx = 0;                    // restart the melody
buttons.waitForRelease(TOP_BUTTON);  // wait here for the button to be released

}
}

2. OrangutanBuzzerExample2

���4�<�>�=�B�C�A�0�C�4�B�7�>�F�H�>�D�2�0�=�D�B�4�C�7�8�B�;�8�1�A�0�A�H�O�Bplay() �<�4�C�7�>�3�C�>�B�C�0�A�C�0�<�4�;�>�3�H�?�;�0�H�8�=�6�	�$�=�2�4�B�C�0�A�C�4�3���C�7�4�<�4�;�>�3�H�F�8�;�;
�?�;�0�H�0�;�;�C�7�4�F�0�H�C�>�C�7�4�4�=�3�F�8�C�7�=�>�5�D�A�C�7�4�A�0�2�C�8�>�=�A�4�@�D�8�A�4�3�5�A�>�<�H�>�D�A�2�>�3�4���0�=�3�C�7�4�A�4�B�C�>�5�H�>�D�A�?�A�>�6�A�0�<�F�8�;�;�4�G�4�2�D�C�4
�0�B�=�>�A�<�0�;�F�7�8�;�4�C�7�4�<�4�;�>�3�H�?�;�0�H�B�8�=�C�7�4�1�0�2�:�6�A�>�D�=�3�	�)�7�4play() �<�4�C�7�>�3�8�B�3�A�8�E�4�=�4�=�C�8�A�4�;�H�1�H�C�7�4�)�8�<�4�A���>�E�4�A�5�;�>�F
�8�=�C�4�A�A�D�?�C�	�)�7�4�C�>�?�D�B�4�A�?�D�B�7�1�D�C�C�>�=�F�8�;�;�?�;�0�H�0�5�D�6�D�4�1�H���0�2�7�5�A�>�<�?�A�>�6�A�0�<�<�4�<�>�A�H���C�7�4�<�8�3�3�;�4�D�B�4�A�?�D�B�7�1�D�C�C�>�=�F�8�;�;
�@�D�8�4�C�;�H�?�;�0�H�C�7�4�� �<�0�9�>�A�B�2�0�;�4�D�?�0�=�3�1�0�2�:�3�>�F�=�5�A�>�<�'���"�� �0�=�3�C�7�4�1�>�C�C�>�<�D�B�4�A�?�D�B�7�1�D�C�C�>�=�F�8�;�;�B�C�>�?�0�=�H�<�4�;�>�3�H
�C�7�0�C���8�B���2�D�A�A�4�=�C�;�H���?�;�0�H�8�=�6���>�A���?�;�0�H���0���B�8�=�6�;�4���=�>�C�4���8�5���C�7�4���1�D�I�I�4�A���8�B���2�D�A�A�4�=�C�;�H���8�=�0�2�C�8�E�4�	

#include <OrangutanLCD.h>
#include <OrangutanPushbuttons.h>
#include <OrangutanBuzzer.h>

/*
* OrangutanBuzzerExample2: for the Orangutan SV-xx8, Orangutan LV-168,
*    and 3pi robot
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*
* This example uses the OrangutanBuzzer library to play a series of notes on
* the buzzer.  It uses the OrangutanPushbuttons library to allow the user
* select which melody plays.
*
* This example demonstrates the use of the OrangutanBuzzer::play() method,
* which plays the specified melody entirely in the background, requiring
* no further action from the user once the method is called.  The CPU
* is then free to execute other code while the melody plays.
*
* http://www.pololu.com/docs/0J17/5.b
* http://www.pololu.com
* http://forum.pololu.com
*/

OrangutanLCD lcd;
OrangutanPushbuttons buttons;
OrangutanBuzzer buzzer;

#include <avr/pgmspace.h>  // this lets us refer to data in program space (i.e. flash)
// store this fugue in program space using the PROGMEM macro.
// Later we will play it directly from program space, bypassing the need to load it
// all into RAM first.
const char fugue[] PROGMEM =

"! O5 L16 agafaea dac+adaea fa<aa<bac#a dac#adaea f"
"O6 dcd<b-d<ad<g d<f+d<gd<ad<b- d<dd<ed<f+d<g d<f+d<gd<ad"
"L8 MS <b-d<b-d MLe-<ge-<g MSc<ac<a ML d<fd<f O5 MS b-gb-g"
"ML >c#e>c#e MS afaf ML gc#gc# MS fdfd ML e<b-e<b-"
"O6 L16ragafaea dac#adaea fa<aa<bac#a dac#adaea faeadaca"
"<b-acadg<b-g egdgcg<b-g <ag<b-gcf<af dfcf<b-f<af"
"<gf<af<b-e<ge c#e<b-e<ae<ge <fe<ge<ad<fd"
"O5 e>ee>ef>df>d b->c#b->c#a>df>d e>ee>ef>df>d"
"e>d>c#>db>d>c#b >c#agaegfe f O6 dc#dfdc#<b c#4";

void setup()                    // run once, when the sketch starts
{

lcd.print("Press a");
lcd.gotoXY(0, 1);
lcd.print("button..");

}

void loop()                     // run over and over again
{

// wait here for one of the three buttons to be pushed
unsigned char button = buttons.waitForButton(ALL_BUTTONS);
lcd.clear();

if (button == TOP_BUTTON)
{

buzzer.playFromProgramSpace(fugue);

lcd.print("Fugue!");
lcd.gotoXY(0, 1);
lcd.print("flash ->");

}
if (button == MIDDLE_BUTTON)
{

buzzer.play("! V8 cdefgab>cbagfedc");
lcd.print("C Major");
lcd.gotoXY(0, 1);
lcd.print("RAM ->");

}
if (button == BOTTOM_BUTTON)
{

if (buzzer.isPlaying())
{

buzzer.stopPlaying();
lcd.print("stopped");

}
else
{

buzzer.playNote(NOTE_A(5), 200, 15);
lcd.print("note A5");

}
}

}
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3. OrangutanBuzzerExample3

���4�<�>�=�B�C�A�0�C�4�B�C�7�4�D�B�4�>�5�C�7�8�B�;�8�1�A�0�A�H�O�B�?�;�0�H�"�>�3�4�����0�=�3�?�;�0�H���7�4�2�:�����<�4�C�7�>�3�B�	���=�C�7�8�B�4�G�0�<�?�;�4���0�D�C�>�<�0�C�8�2�?�;�0�H�<�>�3�4�8�B
�D�B�4�3�C�>�0�;�;�>�F�C�7�4�<�4�;�>�3�H�C�>�:�4�4�?�?�;�0�H�8�=�6�F�7�8�;�4�8�C�1�;�8�=�:�B�C�7�4�A�4�3�D�B�4�A�!�����	 �)�7�4�=�C�7�4�<�>�3�4�8�B�B�F�8�C�2�7�4�3�C�>�?�;�0�H���2�7�4�2�:
�<�>�3�4�3�D�A�8�=�6�0�?�7�0�B�4�F�7�4�A�4�F�4�0�A�4�C�A�H�8�=�6�C�>�0�2�2�D�A�0�C�4�;�H�<�4�0�B�D�A�4�C�8�<�4�	�)�7�4�A�4�0�A�4�C�7�A�4�4���3�4�5�8�=�4�<�0�2�A�>�B�C�7�0�C�0�;�;�>�F�H�>�D
�C�>�A�D�=�C�7�8�B�4�G�0�<�?�;�4�8�=�3�8�5�5�4�A�4�=�C�F�0�H�B�0�=�3�>�1�B�4�A�E�4�C�7�4�A�4�B�D�;�C�	�%�;�4�0�B�4�B�4�4�C�7�4�2�>�<�<�4�=�C�B�0�C�C�7�4�C�>�?�>�5�C�7�4�B�:�4�C�2�7�5�>�A
�<�>�A�4���3�4�C�0�8�;�4�3���8�=�5�>�A�<�0�C�8�>�=�	

#include <OrangutanLCD.h>
#include <OrangutanLEDs.h>
#include <OrangutanBuzzer.h>

/*
* OrangutanBuzzerExample3: for the Orangutan LV-168, Orangutan SV-xx8,
*    or 3pi robot
*
* This example uses the OrangutanBuzzer library to play a series of notes on
* the target's piezo buzzer.
*
* This example demonstrates the use of the OrangutanBuzzer::playMode()
* and OrangutanBuzzer::playCheck() methods, which allow you to select
* whether the melody sequence initiated by OrangutanBuzzer::play() is
* played automatically in the background by the Timer1 interrupt, or if
* the play is driven by the playCheck() method in your main loop.
*
* Automatic play mode should be used if your code has a lot of delays
* and is not time critical.  In this example, automatic mode is used
* to allow the melody to keep playing while we blink the red user LED.
*
* Play-check mode should be used during parts of your code that are
* time critical.  In automatic mode, the Timer1 interrupt is very slow
* when it loads the next note, and this can delay the execution of your.
* Using play-check mode allows you to control when the next note is
* loaded so that it doesn't occur in the middle of some time-sensitive
* measurement.  In our example we use play-check mode to keep the melody
* going while performing timing measurements using Timer2.  After the
* measurements, the maximum time measured is displayed on the LCD.
*
* Immediately below are three #define statements that allow you to alter
* the way this program runs.  You should have one of the three lines
* uncommented while commenting out the other two:
*
* If only WORKING_CORRECTLY is uncommented, the program should run in its
* ideal state, using automatic play mode during the LED-blinking phase
* and using play-check mode during the timing phase.  The maximum recorded
* time should be 20, as expected.
*
* If only ALWAYS_AUTOMATIC is uncommented, the program will use automatic
* play mode during both the LED-blinking phase and the timing phase.  Here
* you will see the effect this has on the time measurements (instead of 20,
* you should see a maximum reading of around 27 or 28).
*
* If only ALWAYS_CHECK is uncommented, the program will be in play-check
* mode during both the LED-blinking phase and the timing phase.  Here you
* will see the effect that the LED-blinking delays have on play-check
* mode (the sequence will be very choppy while the LED is blinking, but
* sound normal during the timing phase).  The maximum timing reading should
* be 20, as expected.
*/

// *** UNCOMMENT ONE OF THE FOLLOWING PRECOMPILER DIRECTIVES ***
// (the remaining two should be commented out)
#define WORKING_CORRECTLY    // this is the right way to use playMode()
//#define ALWAYS_AUTOMATIC   // playMode() is always PLAY_AUTOMATIC (timing is inaccurate)
//#define ALWAYS_CHECK       // playMode() is always PLAY_CHECK (delays interrupt the sequence)

OrangutanLEDs leds;
OrangutanBuzzer buzzer;
OrangutanLCD lcd;

#include <avr/pgmspace.h>
const char rhapsody[] PROGMEM = "O6 T40 L16 d#<b<f#<d#<f#<bd#f#"

"T80 c#<b-<f#<c#<f#<b-c#8"
"T180 d#b<f#d#f#>bd#f#c#b-<f#c#f#>b-c#8 c>c#<c#>c#<b>c#<c#>c#c>c#<c#>c#<b>c#<c#>c#"
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"c>c#<c#>c#<b->c#<c#>c#c>c#<c#>c#<b->c#<c#>c#"
"c>c#<c#>c#f>c#<c#>c#c>c#<c#>c#f>c#<c#>c#"
"c>c#<c#>c#f#>c#<c#>c#c>c#<c#>c#f#>c#<c#>c#d#bb-bd#bf#d#c#b-ab-c#b-f#d#";

void setup()                    // run once, when the sketch starts
{

TCCR2A = 0;         // configure timer2 to run at 78 kHz
TCCR2B = 0x06;      // and overflow when TCNT2 = 256 (~3 ms)
buzzer.playFromProgramSpace(rhapsody);

}

void loop()                     // run over and over again
{

// allow the sequence to keep playing automatically through the following delays
#ifndef ALWAYS_CHECK

buzzer.playMode(PLAY_AUTOMATIC);
#else

buzzer.playMode(PLAY_CHECK);
#endif

lcd.gotoXY(0, 0);
lcd.print("blink!");
int i;
for (i = 0; i < 8; i++)
{

#ifdef ALWAYS_CHECK
buzzer.playCheck();

#endif
leds.red(HIGH);
delay(500);
leds.red(LOW);
delay(500);

}

lcd.gotoXY(0, 0);
lcd.print("timing");
lcd.gotoXY(0, 1);
lcd.print("        ");    // clear bottom LCD line
// turn off automatic playing so that our time-critical code won't be interrupted by
// the buzzer's long timer1 interrupt.  Otherwise, this interrupt could throw off our
// timing measurements.  Instead, we will now use playCheck() to keep the sequence
// playing in a way that won't throw off our measurements.

#ifndef ALWAYS_AUTOMATIC
buzzer.playMode(PLAY_CHECK);

#endif
unsigned char maxTime = 0;
for (i = 0; i < 8000; i++)
{

TCNT2 = 0;
while (TCNT2 < 20)    // time for ~250 us

;
if (TCNT2 > maxTime)

maxTime = TCNT2;    // if the elapsed time is greater than the previous max, save it
#ifndef ALWAYS_AUTOMATIC

buzzer.playCheck();   // check if it's time to play the next note and play it if so
#endif

}
lcd.gotoXY(0, 1);
lcd.print("max=");
lcd.print((unsigned int)maxTime);
lcd.print(' ');  // overwrite any left over characters

}

5.c.OrangutanLCD - LCD Contr ol Library
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Overview
�)�7�8�B�;�8�1�A�0�A�H�6�8�E�4�B�H�>�D�C�7�4�0�1�8�;�8�C�H�C�>�2�>�=�C�A�>�;�C�7�4���P�
�2�7�0�A�0�2�C�4�A�!���� �>�=�C�7�43pi robot [http://www .pololu.com/catalog/

product/975]�� Orangutan SV-xx8 [http://www .pololu.com/catalog/product/1227]�� �0�=�3 Orangutan LV-168
[http://www .pololu.com/catalog/product/775]�	 ���C�8�<�?�;�4�<�4�=�C�B�C�7�4�B�C�0�=�3�0�A�3�����1�8�C�������������� �?�A�>�C�>�2�>�;���0�=�3�8�C�D�B�4�B�C�7�4�1�D�B�H��
�F�0�8�C���5�;�0�6�5�4�0�C�D�A�4�C�>�0�E�>�8�3�C�7�4�D�=�=�4�2�4�B�B�0�A�8�;�H�;�>�=�6�3�4�;�0�H�B�?�A�4�B�4�=�C�8�=�>�C�7�4�A�����1�8�C�!���� ���A�3�D�8�=�>�;�8�1�A�0�A�8�4�B�	�)�7�8�B
�2�>�<�?�A�4�7�4�=�B�8�E�4�;�8�1�A�0�A�H�8�B�<�4�0�=�C�C�>�>�5�5�4�A�0�B�<�D�2�7�!���� �2�>�=�C�A�>�;�0�B�?�>�B�B�8�1�;�4���B�>�8�C�<�>�B�C�;�8�:�4�;�H�6�8�E�4�B�H�>�D�<�>�A�4�<�4�C�7�>�3�B
�C�7�0�=�H�>�D�=�4�4�3�	�. �>�D�2�0�=�2�>�<�<�4�=�C�>�D�C�D�=�=�4�4�3�4�3�<�4�C�7�>�3�B���4�	�6�	�B�7�>�F���D�A�B�>�A�������8�=�$�A�0�=�6�D�C�0�=�!�����	�2�?�?�C�>�<�0�:�4�C�7�8�B
�;�8�1�A�0�A�H�B�<�0�;�;�4�A�	���5�H�>�D�3�>�C�7�8�B���A�4�<�4�<�1�4�A�C�>�3�4�;�4�C�4�$�A�0�=�6�D�C�0�=�!�����	�>�B�>�0�=�3�A�4�B�C�0�A�C�C�7�4���A�3�D�8�=�>������ �B�>�C�7�0�C�C�7�4�;�8�1�A�0�A�H
�F�8�;�;���1�4���A�4�2�>�<�?�8�;�4�3�	

�)�7�8�B�;�8�1�A�0�A�H�8�B�3�4�B�8�6�=�4�3�C�>�6�A�0�2�4�5�D�;�;�H�7�0�=�3�;�4�0�;�C�4�A�=�0�C�4�D�B�4�>�5�C�7�4�5�>�D�A�!���� �3�0�C�0�;�8�=�4�B�	���C�F�8�;�;�2�7�0�=�6�4�C�7�4�8�A�3�0�C�0
�3�8�A�4�2�C�8�>�=�A�4�6�8�B�C�4�A�B�0�=�3�>�D�C�?�D�C�B�C�0�C�4�B�>�=�;�H�F�7�4�=�=�4�4�3�4�3�5�>�A�0�=�!���� �2�>�<�<�0�=�3���0�5�C�4�A�F�7�8�2�7�8�C�F�8�;�;�8�<�<�4�3�8�0�C�4�;�H�A�4�B�C�>�A�4
�C�7�4�A�4�6�8�B�C�4�A�B�C�>�C�7�4�8�A�?�A�4�E�8�>�D�B�B�C�0�C�4�B�	�)�7�8�B�0�;�;�>�F�B�C�7�4�!���� �3�0�C�0�;�8�=�4�B�C�>�5�D�=�2�C�8�>�=�0�B�?�D�B�7�1�D�C�C�>�=�8�=�?�D�C�B�0�=�3�0�=�!����
�3�A�8�E�4�A���>�=���C�7�4���$�A�0�=�6�D�C�0�=���0�=�3�����?�8�	

�. �>�D�3�>�=�>�C�=�4�4�3�C�>�8�=�8�C�8�0�;�8�I�4�H�>�D�A�$�A�0�=�6�D�C�0�=�!�����>�1�9�4�2�C�1�4�5�>�A�4�D�B�4�	���;�;�8�=�8�C�8�0�;�8�I�0�C�8�>�=�8�B�?�4�A�5�>�A�<�4�3�0�D�C�>�<�0�C�8�2�0�;�;�H
�F�7�4�=���=�4�4�3�4�3�	

���;�;�>�5�C�7�4�<�4�C�7�>�3�B�8�=�C�7�8�B�2�;�0�B�B�0�A�4�B�C�0�C�8�2���H�>�D�B�7�>�D�;�3�=�4�E�4�A�7�0�E�4�<�>�A�4�C�7�0�=�>�=�4�8�=�B�C�0�=�2�4�>�5�0�=�$�A�0�=�6�D�C�0�=�!�����>�1�9�4�2�C
�8�=���H�>�D�A���B�:�4�C�2�7�	

Programming Orangutans and the 3pi Robot from the Arduino Environment© 2001Ð2012 Pololu Corporation

5. Arduino Libraries for the Orangutan and 3pi Robot Page 43 of 60

http://www.pololu.com/catalog/product/975
http://www.pololu.com/catalog/product/975
http://www.pololu.com/catalog/product/1227
http://www.pololu.com/catalog/product/775
http://www.pololu.com/catalog/product/775


OrangutanLCD Methods
���>�<�?�;�4�C�4�3�>�2�D�<�4�=�C�0�C�8�>�=�>�5�C�7�8�B�;�8�1�A�0�A�H�O�B�<�4�C�7�>�3�B�2�0�=�1�4�5�>�D�=�3�8�=Section5 �>�5�C�7�4Pololu AVR Library Command
Reference[http://www .pololu.com/docs/0J18]�	
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Usage Examples
�)�7�8�B�;�8�1�A�0�A�H�2�>�<�4�B�F�8�C�7�C�F�>�4�G�0�<�?�;�4�B�:�4�C�2�7�4�B�C�7�0�C�H�>�D�2�0�=�;�>�0�3�1�H�6�>�8�=�6�C�>File > Examples> OrangutanLCD�	
�#�>�C�4�C�7�0�C�<�>�B�C�>�5�C�7�4�>�C�7�4�A�;�8�1�A�0�A�8�4�B�7�0�E�4�4�G�0�<�?�;�4�B�:�4�C�2�7�4�B�C�7�0�C�D�B�4�C�7�4�!������ �B�>�?�;�4�0�B�4�B�4�4�C�7�4�B�4�5�>�A�<�>�A�4
�$�A�0�=�6�D�C�0�=�!�������D�B�0�6�4���4�G�0�<�?�;�4�B�	

1. OrangutanLCDExample

���4�<�>�=�B�C�A�0�C�4�B���B�7�8�5�C�8�=�6���C�7�4���2�>�=�C�4�=�C�B���>�5���C�7�4���3�8�B�?�;�0�H���1�H���<�>�E�8�=�6���C�7�4���F�>�A�3���M���4�;�;�>�N���0�A�>�D�=�3���C�7�4���C�F�>���;�8�=�4�B���>�5���C�7�4���!�����	

#include <OrangutanLCD.h>

/*
* OrangutanLCDExample for the Orangutan LV-168, Orangutan SV-xx8,
*     or 3pi robot
*
* This example uses the OrangutanLCD library to write "Hello"
* on the LCD and then move it around the display area.
*/

OrangutanLCD lcd;

void setup()                    // run once, when the sketch starts
{
}

void loop()                     // run over and over again
{

lcd.print("Hello");           // display "Hello" at (0, 0), a.k.a. upper-left
delay(200);

// shift the display right every 200ms three times
lcd.scroll(LCD_RIGHT, 3, 200);
lcd.clear();                  // clear the LCD
lcd.gotoXY(3, 1);             // go to the fourth character of the second LCD line
lcd.print("Hello");           // display "Hello" at (3, 1), a.k.a. lower-right
delay(200);

// shift the display left every 200ms three times
lcd.scroll(LCD_LEFT, 3, 200);
lcd.clear();                  // clear the LCD

}

1. OrangutanLCDExample2

���4�<�>�=�B�C�A�0�C�4�B�2�A�4�0�C�8�=�6�0�=�3�3�8�B�?�;�0�H�8�=�6�2�D�B�C�>�<�2�7�0�A�0�2�C�4�A�B�>�=�C�7�4�!�����	 �)�7�4�5�>�;�;�>�F�8�=�6�?�8�2�C�D�A�4�B�7�>�F�B�0�=�4�G�0�<�?�;�4�>�5
�2�D�B�C�>�<���2�7�0�A�0�2�C�4�A�B�����D�B�8�=�6���C�7�4�<���C�>���3�8�B�?�;�0�H���0���1�0�A���6�A�0�?�7���>�5���B�4�=�B�>�A���A�4�0�3�8�=�6�B���0�=�3���0���B�<�8�;�4�H���5�0�2�4��

#include <OrangutanPushbuttons.h>
#include <OrangutanLCD.h>
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#include <stdlib.h>        // used for its "random" and "srandom" functions

/*
* OrangutanLCDExample2: for the Orangutan SV-xx8, Orangutan LV-168 or 3pi robot
*
* This example uses the OrangutanLCD library to display custom characters on
* the LCD.  Simply push a any user pushbutton to display a new, randomly
* chosen mood character.
*/

OrangutanLCD lcd;

// define some custom "mood" characters
#include <avr/pgmspace.h>  // this lets us refer to data in program space (i.e. flash)
const char happy[] PROGMEM = {

0b00000,  // the 5 bits that make up the top row of the 5x8 character
0b01010,
0b01010,
0b01010,
0b00000,
0b10001,
0b01110,
0b00000

};

const char sad[] PROGMEM = {
0b00000,
0b01010,
0b01010,
0b01010,
0b00000,
0b01110,
0b10001,
0b00000

};

const char indifferent[] PROGMEM = {
0b00000,
0b01010,
0b01010,
0b01010,
0b00000,
0b00000,
0b01110,
0b00000

};

const char surprised[] PROGMEM = {
0b00000,
0b01010,
0b01010,
0b00000,
0b01110,
0b10001,
0b10001,
0b01110

};

const char mocking[] PROGMEM = {
0b00000,
0b01010,
0b01010,
0b01010,
0b00000,
0b11111,
0b00101,
0b00010

};

char prevMood = 5;

void setup()                    // run once, when the sketch starts
{

lcd.loadCustomCharacter(happy, 0);
lcd.loadCustomCharacter(sad, 1);
lcd.loadCustomCharacter(indifferent, 2);
lcd.loadCustomCharacter(surprised, 3);
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lcd.loadCustomCharacter(mocking, 4);
lcd.clear();                  // must be called before we can use the custom chars
lcd.print("mood: ?");

// initialize the random number generator based on how long we hold the button the first time
OrangutanPushbuttons::waitForPress(ALL_BUTTONS);
long seed = 0;
while(OrangutanPushbuttons::isPressed(ALL_BUTTONS))

seed++;
srandom(seed);                // the same as: randomSeed((unsigned int)seed);

}

void loop()                     // run over and over again
{

lcd.gotoXY(6, 0);             // move cursor to the correct position

// ensure we get a new mood that differs from the previous
char mood;
do
{

mood = random()%5;          // the same as: mood = random(5);
} while (mood == prevMood);
prevMood = mood;

lcd.print(mood);   // print a random mood character

// wait for any button to be pressed
OrangutanPushbuttons::waitForButton(ALL_BUTTONS);

}

5.d.OrangutanLEDs - LED Control Library
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Overview
�)�7�8�B�;�8�1�A�0�A�H�0�;�;�>�F�B�H�>�D�C�>�4�0�B�8�;�H�2�>�=�C�A�>�;�C�7�4�!�������B���>�=�C�7�43pi robot [http://www .pololu.com/catalog/product/975]��
Orangutan SV-xx8 [http://www .pololu.com/catalog/product/1227]��Orangutan LV-168[http://www .pololu.com/catalog/product/

775]���0�=�3Baby Orangutan B [http://www .pololu.com/catalog/product/1220]�	�$�=�C�7�4�$�A�0�=�6�D�C�0�=�(�+���G�G���0�=�3�!�+�����������C�7�4�A�4
�0�A�4�C�F�>�D�B�4�A�!�����B �0�A�4�>�=�C�7�4�C�>�?�B�8�3�4�>�5�C�7�4�%�����F�8�C�7�C�7�4�A�4�3�!���� �>�=�C�7�4�1�>�C�C�>�<�;�4�5�C�0�=�3�C�7�4�6�A�4�4�=�!���� �>�=�C�7�4
�C�>�?�A�8�6�7�C�	�$�=�C�7�4���?�8���C�7�4�A�4�0�A�4�C�F�>�D�B�4�A�!�����B �>�=�C�7�4�1�>�C�C�>�<�B�8�3�4�>�5�C�7�4�%�����F�8�C�7�C�7�4�A�4�3�!���� �>�=�C�7�4�A�8�6�7�C���F�7�4�=
�;�>�>�:�8�=�6�0�C�C�7�4�1�>�C�C�>�<���0�=�3�C�7�4�6�A�4�4�=�!���� �>�=�C�7�4�;�4�5�C�	���3�3�8�C�8�>�=�0�;�!�����B �8�=�2�;�D�3�4�3�F�8�C�7�C�7�4���?�8�<�0�H�1�4�B�>�;�3�4�A�4�3�8�=�>�=
�C�7�4�C�>�?�B�8�3�4���8�=�?�0�A�0�;�;�4�;�F�8�C�7�C�7�4�B�D�A�5�0�2�4���<�>�D�=�C�!�����B �>�=�C�7�4�D�=�3�4�A�B�8�3�4���5�>�A�4�0�B�8�4�A�E�8�4�F�8�=�6�	�)�7�4���0�1�H�$�A�0�=�6�D�C�0�=�7�0�B
�0���B�8�=�6�;�4���A�4�3���!�������0�=�3���=�>���6�A�4�4�=���!�����	

�#�>�C�4�C�7�0�C�C�7�4�A�4�3�!���� �8�B�>�=�C�7�4�B�0�<�4�?�8�=�0�B�C�7�4�*���' �)�� �B�4�A�8�0�;�C�A�0�=�B�<�8�C�C�4�A���%���������B�>�8�5�H�>�D�0�A�4�D�B�8�=�6�*���' �)�� �5�>�A�B�4�A�8�0�;
�C�A�0�=�B�<�8�B�B�8�>�=�C�7�4�=�C�7�4�A�4�3�!���� �2�>�<�<�0�=�3�B�F�8�;�;�=�>�C�F�>�A�:���0�=�3�H�>�D�F�8�;�;�B�4�4�C�7�4�A�4�3�!���� �1�;�8�=�:�1�A�8�4�5�;�H�F�7�4�=�4�E�4�A�3�0�C�0
�8�B�C�A�0�=�B�<�8�C�C�4�3�>�=�*���' �)���	 �#�>�C�4�C�7�0�C�C�7�4�6�A�4�4�=�!���� �8�B�>�=�C�7�4�B�0�<�4�?�8�=�0�B�0�=�!���� �2�>�=�C�A�>�;�?�8�=���C�7�4�6�A�4�4�=�!���� �F�8�;�;
�1�;�8�=�:���1�A�8�4�5�;�H���F�7�4�=�4�E�4�A���3�0�C�0���8�B���B�4�=�C���C�>���C�7�4���!���������1�D�C���C�7�4���C�F�>���5�D�=�2�C�8�>�=�B���F�8�;�;���>�C�7�4�A�F�8�B�4���=�>�C���8�=�C�4�A�5�4�A�4���F�8�C�7���4�0�2�7���>�C�7�4�A�	

�. �>�D�3�>�=�>�C�=�4�4�3�C�>�8�=�8�C�8�0�;�8�I�4�H�>�D�A�$�A�0�=�6�D�C�0�=�!�����B�>�1�9�4�2�C�1�4�5�>�A�4�D�B�4�	���;�;�8�=�8�C�8�0�;�8�I�0�C�8�>�=�8�B�?�4�A�5�>�A�<�4�3�0�D�C�>�<�0�C�8�2�0�;�;�H
�F�7�4�=���=�4�4�3�4�3�	

���;�;�>�5�C�7�4�<�4�C�7�>�3�B�8�=�C�7�8�B�2�;�0�B�B�0�A�4�B�C�0�C�8�2���H�>�D�B�7�>�D�;�3�=�4�E�4�A�7�0�E�4�<�>�A�4�C�7�0�=�>�=�4�8�=�B�C�0�=�2�4�>�5�0�=�$�A�0�=�6�D�C�0�=�!�����B�>�1�9�4�2�C
�8�=���H�>�D�A���B�:�4�C�2�7�	
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OrangutanLEDs Methods
���>�<�?�;�4�C�4�3�>�2�D�<�4�=�C�0�C�8�>�=�>�5�C�7�8�B�;�8�1�A�0�A�H�O�B�<�4�C�7�>�3�B�2�0�=�1�4�5�>�D�=�3�8�=Section6 �>�5�C�7�4Pololu AVR Library Command
Reference[http://www .pololu.com/docs/0J18]�	
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Usage Examples
�)�7�8�B���;�8�1�A�0�A�H���2�>�<�4�B���F�8�C�7���0�=���4�G�0�<�?�;�4���B�:�4�C�2�7���C�7�0�C���H�>�D���2�0�=���;�>�0�3���1�H���6�>�8�=�6���C�>File > Examples > OrangutanLEDs�	

1. OrangutanLEDExample

���;�C�4�A�=�0�C�4�;�H�1�;�8�=�:�B�C�7�4�A�4�3�0�=�3�6�A�4�4�=�!�����B �>�=�C�7�4�$�A�0�=�6�D�C�0�=�(�+���G�G�����$�A�0�=�6�D�C�0�=�!�+�����������>�A���?�8�A�>�1�>�C�	���5�H�>�D�A�D�=
�C�7�8�B�?�A�>�6�A�0�<�>�=�C�7�4���0�1�H�$�A�0�=�6�D�C�0�=���� �H�>�D�F�8�;�;�>�=�;�H�B�4�4�C�7�4�A�4�3�D�B�4�A�!���� �1�;�8�=�:���1�D�C�H�>�D�2�0�=�2�>�=�=�4�2�C�0�=�4�G�C�4�A�=�0�;
�!���� �C�>�?�8�=�%���������A�3�D�8�=�>�?�8�=���� �8�5�H�>�D�F�0�=�C�C�>�B�4�4�C�7�4�B�4�2�>�=�3�!���� �1�;�8�=�:�	���5�H�>�D�3�>�C�7�8�B���3�>�=�O�C�5�>�A�6�4�C�C�>�8�=�2�;�D�3�4�0
�2�D�A�A�4�=�C���;�8�<�8�C�8�=�6���A�4�B�8�B�C�>�A��

#include <OrangutanLEDs.h>

/*
* OrangutanLEDExample: for the 3pi robot, Orangutan LV 168, Orangutan SV-xx8,
*   or Baby Orangutan B.
*
* This program uses the OrangutanLEDs functions to control the red and green
* LEDs on the 3pi robot or Orangutan.  It will also work to control the red
* LED on the Baby Orangutan B (which lacks a second, green LED).
*/

OrangutanLEDs leds;

void setup()                    // run once, when the sketch starts
{
}

void loop()                     // run over and over again
{

leds.red(HIGH);               // red LED on
delay(1000);                  // waits for a second
leds.red(LOW);                // red LED off
delay(1000);                  // waits for a second
leds.green(HIGH);             // green LED on (will not work on the Baby Orangutan)
delay(500);                   // waits for 0.5 seconds
leds.green(LOW);              // green LED off (will not work on the Baby Orangutan)
delay(500);                   // waits for 0.5 seconds

}

5.e.OrangutanMotors - Motor Contr ol Library
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Overview
�)�7�8�B�;�8�1�A�0�A�H�6�8�E�4�B�H�>�D�C�7�4�0�1�8�;�8�C�H�C�>�2�>�=�C�A�>�;�C�7�4�<�>�C�>�A�3�A�8�E�4�A�B�>�=�C�7�43pi robot [http://www .pololu.com/catalog/product/

975]�� Orangutan SV-xx8 [http://www .pololu.com/catalog/product/1227]�� Orangutan LV-168 [http://www .pololu.com/catalog/

product/775]���0�=�3Baby Orangutan B [http://www .pololu.com/catalog/product/1220]�	���C�0�2�2�>�<�?�;�8�B�7�4�B�C�7�8�B�1�H�D�B�8�=�6�C�7�4�5�>�D�A
�7�0�A�3�F�0�A�4�%�,�" �>�D�C�?�D�C�B�5�A�>�<�C�8�<�4�A�B�)�8�<�4�A���0�=�3�)�8�<�4�A�
���B�>this library will conflict with any other libraries that
rely on or reconfigure Timer0 or Timer2�	

���4�2�0�D�B�4�C�7�4���A�3�D�8�=�>�4�=�E�8�A�>�=�<�4�=�C�A�4�;�8�4�B�>�=�)�8�<�4�A���5�>�A�C�8�<�8�=�6�5�D�=�2�C�8�>�=�B�;�8�:�4�<�8�;�;�8�B�����0�=�3�3�4�;�0�H�������C�7�8�B
�;�8�1�A�0�A�H�2�0�=�=�>�C�A�4�2�>�=�5�8�6�D�A�4�C�7�4�C�8�<�4�A�B���2�>�=�B�4�@�D�4�=�C�;�H��the PWM outputs are limited to a fr equency
of 1.25kHz in the Arduino environment�	 ���=�<�0�=�H�2�0�B�4�B���C�7�8�B�F�8�;�;�A�4�B�D�;�C�8�=�0�=�0�D�3�8�1�;�4�<�>�C�>�A
�F�7�8�=�4�	�)�>�0�E�>�8�3�C�7�8�B�?�A�>�1�;�4�<���H�>�D�2�0�=�8�=�B�C�4�0�3�?�A�>�6�A�0�<�8�=�� �>�A������ �F�8�C�7�C�7�4Pololu AVR Library
[http://www .pololu.com/docs/0J20]���F�7�8�2�7�0�;�;�>�F�B�H�>�D�C�>�D�B�4�C�7�4�<�>�C�>�A�3�A�8�E�4�A�B�0�C�7�8�6�7�4�A�%�,�" �5�A�4�@�D�4�=�2�8�4�B�	

�. �>�D�3�>�=�>�C�=�4�4�3�C�>�8�=�8�C�8�0�;�8�I�4�H�>�D�A�$�A�0�=�6�D�C�0�=�"�>�C�>�A�B�>�1�9�4�2�C�1�4�5�>�A�4�D�B�4�	���;�;�8�=�8�C�8�0�;�8�I�0�C�8�>�=�8�B�?�4�A�5�>�A�<�4�3�0�D�C�>�<�0�C�8�2�0�;�;�H
�F�7�4�=���=�4�4�3�4�3�	

���;�;�>�5�C�7�4�<�4�C�7�>�3�B�8�=�C�7�8�B�2�;�0�B�B�0�A�4�B�C�0�C�8�2���H�>�D�B�7�>�D�;�3�=�4�E�4�A�7�0�E�4�<�>�A�4�C�7�0�=�>�=�4�8�=�B�C�0�=�2�4�>�5�0�=�$�A�0�=�6�D�C�0�=�"�>�C�>�A�B
�>�1�9�4�2�C���8�=���H�>�D�A���B�:�4�C�2�7�	
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OrangutanMotors Methods
���>�<�?�;�4�C�4�3�>�2�D�<�4�=�C�0�C�8�>�=�>�5�C�7�8�B�;�8�1�A�0�A�H�O�B�<�4�C�7�>�3�B�2�0�=�1�4�5�>�D�=�3�8�=Section7 �>�5�C�7�4Pololu AVR Library Command
Reference[http://www .pololu.com/docs/0J18]�	
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Usage Examples
�)�7�8�B�;�8�1�A�0�A�H�2�>�<�4�B�F�8�C�7�C�F�>�4�G�0�<�?�;�4�B�:�4�C�2�7�4�B�C�7�0�C�H�>�D�2�0�=�;�>�0�3�1�H�6�>�8�=�6�C�>File > Examples> OrangutanMotors�	

1. OrangutanMotorExample

���4�<�>�=�B�C�A�0�C�4�B���2�>�=�C�A�>�;�;�8�=�6���C�7�4���<�>�C�>�A�B���D�B�8�=�6���C�7�4���C�A�8�<�<�4�A���?�>�C�4�=�C�8�>�<�4�C�4�A���0�=�3���D�B�4�B���C�7�4���A�4�3���!�������5�>�A���5�4�4�3�1�0�2�:�	

#include <OrangutanLEDs.h>
#include <OrangutanAnalog.h>
#include <OrangutanMotors.h>

/*
* OrangutanMotorExample for the 3pi robot, Orangutan LV-168, Orangutan SV-xx8,
*   and Baby Orangutan B
*
* This example uses the OrangutanMotors library to drive
* motors in response to the position of user trimmer potentiometer
* and blinks the red user LED at a rate determined by the trimmer
* potentiometer position.  It uses the OrangutanAnalog library to measure
* the trimpot position, and it uses the OrangutanLEDs library to provide
* limited feedback with the red user LED.
*
* http://www.pololu.com/docs/0J17/5.e
* http://www.pololu.com
* http://forum.pololu.com
*/

OrangutanAnalog analog;
OrangutanLEDs leds;
OrangutanMotors motors;

void setup()               // run once, when the sketch starts
{

}

void loop()                // run over and over again
{

// note that the following line could also be accomplished with:
// int pot = analog.read(7);
int pot = analog.readTrimpot();    // determine the trimpot position
int motorSpeed = pot/2-256;  // turn pot reading into number between -256 and 255
if(motorSpeed == -256)

motorSpeed = -255; // 256 is out of range
motors.setSpeeds(motorSpeed, motorSpeed);

int ledDelay = motorSpeed;
if(ledDelay < 0)

ledDelay = -ledDelay;  // make the delay a non-negative number
ledDelay = 256-ledDelay; // the delay should be short when the speed is high

leds.red(HIGH);       // turn red LED on
delay(ledDelay);

leds.red(LOW);       // turn red LED off
delay(ledDelay);

}

2. OrangutanMotorExample2

���4�<�>�=�B�C�A�0�C�4�B�2�>�=�C�A�>�;�;�8�=�6�C�7�4�<�>�C�>�A�B�D�B�8�=�6�C�7�4�C�A�8�<�<�4�A�?�>�C�4�=�C�8�>�<�4�C�4�A���1�D�C�8�C�D�B�4�B�C�7�4�!���� �5�>�A�<�>�B�C�>�5�C�7�4�5�4�4�3�1�0�2�:��
�B�>���8�C���F�8�;�;���=�>�C���5�D�;�;�H���F�>�A�:���>�=���C�7�4�����0�1�H���$�A�0�=�6�D�C�0�=�	

#include <OrangutanLEDs.h>
#include <OrangutanAnalog.h>
#include <OrangutanMotors.h>
#include <OrangutanLCD.h>

/*
* OrangutanMotorExample2 for the 3pi robot, Orangutan LV-168,
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*    and Orangutan SV-xx8.
*
* This example uses the OrangutanMotors and OrangutanLCD libraries to drive
* motors in response to the position of user trimmer potentiometer
* and to display the potentiometer position and desired motor speed
* on the LCD.  It uses the OrangutanAnalog library to measure the
* trimpot position, and it uses the OrangutanLEDs library to provide
* limited feedback with the red and green user LEDs.
*/

OrangutanLCD lcd;
OrangutanMotors motors;
OrangutanAnalog analog;
OrangutanLEDs leds;

void setup()                    // run once, when the sketch starts
{

}

void loop()                     // run over and over again
{

// note that the following line could also be accomplished with:
// int pot = analogRead(7);
int pot = analog.readTrimpot();  // determine the trimpot position

// avoid clearing the LCD to reduce flicker
lcd.gotoXY(0, 0);
lcd.print("pot=");
lcd.print(pot);               // print the trim pot position (0 - 1023)
lcd.print("  ");              // overwrite any left over digits

int motorSpeed = (512 - pot) / 2;
lcd.gotoXY(0, 1);
lcd.print("spd=");
lcd.print(motorSpeed);        // print the resulting motor speed (-255 - 255)
lcd.print("   ");
motors.setSpeeds(motorSpeed, motorSpeed);  // set speeds of motors 1 and 2

// all LEDs off
leds.red(LOW);
leds.green(LOW);
// turn green LED on when motors are spinning forward
if (motorSpeed > 0)

leds.green(HIGH);
// turn red LED on when motors are spinning in reverse
if (motorSpeed < 0)

leds.red(HIGH);
delay(100);

}

5.f. OrangutanPushbuttons - Pushbutton Interface Library
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Overview
�)�7�8�B�;�8�1�A�0�A�H�0�;�;�>�F�B�H�>�D�C�>�4�0�B�8�;�H�8�=�C�4�A�5�0�2�4�F�8�C�7�C�7�4�C�7�A�4�4�D�B�4�A�?�D�B�7�1�D�C�C�>�=�B�>�= �C�7�43pi robot
[http://www .pololu.com/catalog/product/975]�� Orangutan SV-xx8 [http://www .pololu.com/catalog/product/1227]�� �0�=�3
Orangutan LV-168 [http://www .pololu.com/catalog/product/775] �1�H�4�8�C�7�4�A�?�>�;�;�8�=�6�5�>�A�C�7�4�B�C�0�C�4�>�5�B�?�4�2�8�5�8�2�1�D�C�C�>�=�B�>�A�1�H
�F�0�8�C�8�=�6�5�>�A�?�A�4�B�B�
�A�4�;�4�0�B�4�4�E�4�=�C�B�>�=�B�?�4�2�8�5�8�0�1�;�4�1�D�C�C�>�=�B�	�)�7�4waitFor____() �<�4�C�7�>�3�B�8�=�C�7�8�B�;�8�1�A�0�A�H�0�D�C�>�<�0�C�8�2�0�;�;�H�C�0�:�4
�2�0�A�4���>�5���1�D�C�C�>�=���3�4�1�>�D�=�2�8�=�6�	

�. �>�D�3�>�=�>�C�=�4�4�3�C�>�8�=�8�C�8�0�;�8�I�4�H�>�D�A�$�A�0�=�6�D�C�0�=�%�D�B�7�1�D�C�C�>�=�B�>�1�9�4�2�C�1�4�5�>�A�4�D�B�4�	���;�; �8�=�8�C�8�0�;�8�I�0�C�8�>�=�8�B�?�4�A�5�>�A�<�4�3
�0�D�C�>�<�0�C�8�2�0�;�;�H���F�7�4�=���=�4�4�3�4�3�	

���;�;�>�5�C�7�4�<�4�C�7�>�3�B�8�=�C�7�8�B�2�;�0�B�B�0�A�4�B�C�0�C�8�2���H�>�D�B�7�>�D�;�3�=�4�E�4�A�7�0�E�4�<�>�A�4�C�7�0�=�>�=�4�8�=�B�C�0�=�2�4�>�5�0�=�$�A�0�=�6�D�C�0�=�%�D�B�7�1�D�C�C�>�=�B
�>�1�9�4�2�C���8�=���H�>�D�A���B�:�4�C�2�7�	
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OrangutanPushbuttons Methods
���>�<�?�;�4�C�4�3�>�2�D�<�4�=�C�0�C�8�>�=�>�5�C�7�8�B�;�8�1�A�0�A�H�O�B�<�4�C�7�>�3�B�2�0�=�1�4�5�>�D�=�3�8�=Section9 �>�5�C�7�4Pololu AVR Library Command
Reference[http://www .pololu.com/docs/0J18]�	
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Usage Examples
�)�7�8�B�;�8�1�A�0�A�H�2�>�<�4�B�F�8�C�7�0�=�4�G�0�<�?�;�4�B�:�4�C�2�7�C�7�0�C�H�>�D�2�0�=�;�>�0�3�1�H�6�>�8�=�6�C�>File > Examples >
OrangutanPushbuttons�	

1. OrangutanPushbuttonExample

���4�<�>�=�B�C�A�0�C�4�B�8�=�C�4�A�5�0�2�8�=�6�F�8�C�7�C�7�4�D�B�4�A�?�D�B�7�1�D�C�C�>�=�B�	���C�F�8�;�;�F�0�8�C�5�>�A�H�>�D�C�>�?�D�B�7�4�8�C�7�4�A�C�7�4�C�>�?�1�D�C�C�>�=�>�A�C�7�4�1�>�C�C�>�<
�1�D�C�C�>�=���0�C�F�7�8�2�7�?�>�8�=�C�8�C�F�8�;�;�3�8�B�?�;�0�H�>�=�C�7�4�!���� �F�7�8�2�7�1�D�C�C�>�=�F�0�B�?�A�4�B�B�4�3�	���C�F�8�;�;�0�;�B�>�3�4�C�4�2�C�F�7�4�=�C�7�0�C�1�D�C�C�>�=�8�B
�B�D�1�B�4�@�D�4�=�C�;�H���A�4�;�4�0�B�4�3���0�=�3���3�8�B�?�;�0�H���C�7�0�C���C�>���C�7�4���!�����	

#include <OrangutanLCD.h>
#include <OrangutanPushbuttons.h>

/*
* OrangutanPushbuttonExample: for the 3pi robot, Orangutan LV-168,
*    and Orangutan SV-xx8
*
* This example uses the OrangutanPushbuttons library to detect user input
* from the pushbuttons, and it uses the OrangutanLCD library to display
* feedback on the LCD.
*/

OrangutanPushbuttons buttons;
OrangutanLCD lcd;

void setup()                    // run once, when the sketch starts
{
}

void loop()                     // run over and over again
{

lcd.clear();
lcd.print("Waiting");

// wait for either the top or bottom buttons to be pressed
// store the value of the pressed button in the variable 'button'
unsigned char button = buttons.waitForPress(TOP_BUTTON | BOTTOM_BUTTON);
lcd.clear();
if (button == TOP_BUTTON)     // display the button that was pressed

lcd.print("top down");
else

lcd.print("bot down");
buttons.waitForRelease(button);  // wait for that button to be released
lcd.clear();
lcd.print("released");      // display that the button was released
delay(1000);

}

5.g.Pololu3pi - Sensor Library for the 3pi Robot
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Overview
�)�7�8�B�;�8�1�A�0�A�H�0�;�;�>�F�B�H�>�D�C�>�4�0�B�8�;�H�8�=�C�4�A�5�0�2�4�F�8�C�7�C�7�4�5�8�E�4�8�=�5�A�0�A�4�3�A�4�5�;�4�2�C�0�=�2�4�B�4�=�B�>�A�B�>�=�C�7�43pi robot
[http://www .pololu.com/catalog/product/975]�	 �#�>�C�4�C�7�0�C�8�=�>�A�3�4�A�C�>�D�B�4�C�7�8�B�;�8�1�A�0�A�H�� you must also include
PololuQTRSensors.h in your sketch�	���.�>�D���B�7�>�D�;�3���7�0�E�4���B�>�<�4�C�7�8�=�6���;�8�:�4���C�7�4���5�>�;�;�>�F�8�=�6���0�C���C�7�4���C�>�?���>�5���H�>�D�A���B�:�4�C�2�7��

#include <Pololu3pi.h>  // gives access to sensor interface functions
#include <PololuQTRSensors.h>  // used by Pololu3pi.h
#include <OrangutanMotors.h>  // gives access to motor control functions
#include <OrangutanBuzzer.h>  // gives access to buzzer control functions
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Usage Examples
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